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Preface

About the System Disk

The Apple® tIGS™ System Disk has two types of programs, called

utilities, thai let you copy, delete, move, and otherwise manipulate

information stored on a disk. These programs also lei you start up

applications and switch between them.

One utility, called the Finder, is mouse-based, requires at least 5I2K

of random-access memory (K.VXf'i, and can be used only with disks

formatted for the ProDOS* operating system.

If your system is equipped to use the Finder, you'll .sec a screen

similar to Figure P-l when you start up the system disk.

xv



Q
Figure P-l

The Finder

By the way: If your Apple IIGS has at least 512K of RAM but

you don't sec the Finder when you .start up the .system disk, it's

bably because you have designated some of the memory on
your memory expansion card to be used as a RAM disk. When
memory is used as a RAM disk, it can't be used by the Finder. See

the Apple FIGS Owner's Guide for instructions on reallocating

memory on the memory expansion card.

The other utility on the system disk, called the System Utilities, is

keyboard-based, requires only 256K of RAM, and can be used with

disks formatted for the ProDOS, DOS 3-3, or Pascal operating

system. If your system is equipped to use only the System Utilities,

you'll see a screen called the Program Launcher, similar to Figure

P-2, when you start up the system disk. You'll start the System
Utilities from the Program Launcher,

xvl Preface: About the System Disk
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Figure P-2
The Program Launcher

By the way.- Ff you have at least 512K of RAM that hasn't been
assigned to a RAM disk, you can use either the Finder or the

em Utilities. If you want 10 work with DOS 3-3 or Pascal disks

or need lo verify that a disk is readable, you must use the System
Utilities.

To learn more about the Finder, turn to Part 1 of this manual To
learn more about the System Utilities and the Program Launcher,

turn to Part 2.

If your Apple HGS is connected to a printer on an AppIeTalk®
network, read Appendix A

If you don't know the meaning of a word (especially a word in bold),

look it up in the glossary at the back of this manual.

About the System Disk xvj



Part 1

The Finder

How to use this guide to learn the Finder

If you're new to

computers or if you want

an overview of the Finder.,, read Chapter 1, which includes a

hands-Oil introduction to the Finder.

If you want to know how to

accomplish a specific task... refer to the slep-by-stcp instructions

in Chapters 2 through 5.

If you want to know how a

ific menu command
works.,, look in Chapter 6, which describes

each menu command.

If you have a problem.., turn to Chapter 7.





Chapter 1

Trying Out the Finder



This chapter introduces you to the Finder's capabilities and

provides a hands-on tutorial in which you can try out the Finder,

Figure 1-1

Before the Finder

Meet the Finder

The Finder is software that does just what its name implies—it finds

and starts applications for you so you don't need to restart your

computer every time you want to use a different application.

In addition lo finding applications, the Finder helps you organize

information. With the Finder, you keep track of information in

much the same way you did before you had a computer. But instead

of using your desk or kitchen table as headquarters for keeping

important documents in order, you use the computer screen as your

base of operation.

Imporlanl You can use the Finder only with ProDOS disks. If you want
to work with Pascal or DOS 3.3 disks, you'll need to use the
System Utilities. For more Information, see Part 2, "System

Utilities.'

This section gives a brief description of the ways the Finder can help

you stay organized.

Working with disks

When working with disks you can use the Finder to

show you what files are stored on a disk

a display the files stored on a disk in several different ways, such as

alphabetically by file name or chronologically by the date the

file was last modified

D prepare a disk to receive information by initializing the disk

make a copy of a whole disk

erase all the information on a disk

O give a disk a new name

Chapter T: Trying Out the Finder



Working with files

A file is a collection of information on a disk. When working with

files, you can use the Finder to

a organize related files by placing them in folders

D make a copy of one or more files, cither on the same disk or on a

different disk

D give a new name to a file

discard files you no longer need

n protect, a file from accidental change by locking iL

n remove the protection from a locked file when you no longer

need to protect it

Working in color

If you have a color monitor, you can use the Finder's color

capability to organize information by color. You use the Color

menu to change the color of icons, the pictures on the screen that

represent the disks, files, and folders you're working with.

If you are writing a novel, for example, you might make incomplete

chapters one color and completed chapters another. If you are

using your computer for both business and personal purposes, you
could use color to distinguish business documents from personal

ones, For more information, sec "The Color Menu" in Chapter 6.

A hands-on tutorial

This section lets you practice using the Finder. Once you have

completed the tutorial, you can turn to subsequent chapters for

detailed information about each Finder function.

If you're an experienced computer user, you may want to skip the

tutorial and go directly to Chapter 2.

A hands-on tutorial
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WRITE-PROTECTED

NOTWRtTE-PROTECTED

Figure 1-2

Writ© protecting a disk

During this tutorial you will learn to

D write protect a disk

c start the Finder

i select and move icons

choose commands From menus and see what a disk contains

[ scroll to change what's visible in a window

expand a window so that it occupies the entire screen

view the content of a disk in different ways

Mart an application

D initialize a disk so that it can receive information

make a backup copy of the system disk

* By the way; This tutorial provides only very brief instructions in

using the mouse to click, drag, and choose commands from pull-

down menus, If you haven't had any experience with these tech-

niques, you may want to work through the Apple IIGS training

disk, Your Tour of the Apple HGS, before you continue. Or you
can begin the tutorial now and turn to the training disk if you find

that you're having trouble.

You can take a break from this practice session at any time. Leave
the Apple UGS turned on. When you're through with your break, you
can simply pick up where you left. off.

Write protecting a disk

You can prevent information on a disk from being changed by
write protecting the disk. To write protect the system disk so that

you don't accidentally change its content while working through the

tutorial, slide the tab to uncover the square opening in the corner of

the disk. (See Figure 1-2.)

Chapter 1: Trying Out the Finder



Starting the Finder

Start the Finder just as you start any other application.

1. PuJ Ihe system disk in the startup drive, metal end first and
label side up.

2. Turn on the monitor.

3. Turn on the Apple tics.

After several seconds, you will see the opening screen of the

Finder, and then the Finder desktop. Like an actual desk, the

desktop is the place where you lay out the documents and folders

you want to work with.

The Finder desktop will look something like Figure 1-3.

SYSTEM.DISK Icon

< Fi Special

Trash Icon

Figure 1-3

The Finder desktop

A hands-on tutorial



An Icon Is o graphic repre-

sentation of a device, a
concept, or o message. You
cannot use spaces In Icon
names, so many Icon names
CSYSTEM.OtSK. for example)
Include a period between
words.

You should see at least two icons on the desktop: the

SYSTEM DISK icon, representing the disk you inserted, and
the Trash icon, representing the place where you discard items

you no longer need, (Depending on what disks or disk drives

are connected to your computer, you may also see icons

representing devices such as a 5.25-inch disk drive, a RAM
disk, or a hard disk. You can ignore those icons for now.)

Important tf you see a rectangle containing several Icons, someone else

has probably used this tutorial and opened the icons Into

windows. You can collapse each window back Into an Icon
by clicking the window's close box, the box In the upper-left

corner of the window. For more detailed instructions, see
"Closing a Window" in Chapter 2.

Selecting and moving icons

With the Finder, it's simple to rearrange your electronic desktop by

moving icons. Thai way, when you're using the Finder on your own,
you can set up your desktop in any way that suits you.

1. Position the pointer on the Trash icon.

2. Click the icon by pressing and releasing the mouse button.

{See Figure 1-4.)

Chapter 1 : Trying Out the Finder
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You select an icon to

designate where your nejcl

action will rake place

Figure 1-4

Selecting the Trash Icon

As you click, the Trash icon is highlighted. The highlighting

shows that the icon is selected

3. Click the SYSTEM.DISK icon.

When the SYSTEM.DISK icon is selected, the Trash icon is no

longer selected.

4. Drag the SYSTEM. DISK icon to change Its position on the

desktop.

Position the pointer on the icon you want to drag.

Press and hold down the mouse button while you move the

mouse. (See Figure 1-5.)

A hands-on tutorial
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Figure 1-5

Dragging an icon

When you release ihe mouse button, the icon will snap into its

new position.

5. Practice moving the SYSTEM. DISK icon and the Trash icon.

You can deselect an icon by clicking anywhere on the desktop
other than on the icon.

Choosing commands and looking in windows

To find out what's stored on a disk, you need to open die icon that

represents thai disk

1. Move the icons on the desktop back to Iheir original

positions. (See Figure 1-6.)

This will make it easier for you to follow along with the

illustrations used in the tutorial.

10 Chapter 1: Trying Out the Finder



Figure 1-6

The desktop with icons in their original positions

2 Select the SYSTEM.DISK Icon by clicking it.

3. Pull down the File menu, but don't choose any menu items.

Position ihe pointer on the word l :ile in the menu bar.

Without moving the mouse, press and hold the mouse button to

display die File menu. Release the mouse button when you're

finished looking at the menu. (See Figure 1-7.)

A hands-on tutorial 11
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Get Info 0\

Duplicate

Put Back

Rencme

Quit c«

Bet Info

Renault

Quit

Figure 1 -8

Choosing the Open command

Ml 1

! ill

Figure 1-7

Pulling down a menu

Commands that appear in black type are commands you can

choose now. Those that are dimmed cannot be chosen now.

e, for instance,, cannot be chosen now.) If you try lo choose

a dimmed command, you'll see a message telling you what you

need to do before the command can be chosen.

In some instances, you can use the keyboard lo give a command
instead of using the mouse to choose a command from a menu.

For exam pi e, to give the Open command, you can press the

letter O while holding down the Apple key. Keyboard alternatives

are displayed to the right of options on pull-down menus. For

more information, see "Menu Shortcuts* in Chapter 6.

4. Choose Open from the File menu.

Position the pointer on the word File in the menu bar.

Press the mouse button and hold it down while you drag the

pointer to the word Open. Then release the mouse button. (See

Figure 1-8.)

1? Chapter 1: Trying Out the Finder



A window Is an area on the
desktop used to display the
directory of a disk or folder. A
directory Is a pictorial, alpha-
betical, or chronological list

of the files and folders stored
on a disk. A (older Is a place
to store related documents.

Title bar

Close box

Zoom box

File icon —

Folder icon

Size box

When you release the mouse button with the Open command
highlighted, you'll see a window ihai contains a directory of
icons representing some of the files and folders stored on the

system disk. (See Figure 1-9.)

« File Edit View Special Color

Important

Figure 1 -9

The SYSTEM. DISK window

ff the window doesn't appear; try again, making sure the
SYSTEM. DISK Icon is selected before you choose Open from the
File menu.

The window has several parts, each of which is used to manipu
late it in a different way. You'll get some practice working
with windows in this tutorial. Complete information about
manipulating windows is included in Chapter 2, "Working
With Windows, Icons, and Text."

A hands-on tutorial 1
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A scroll bar Is the long bar at
the bottom or on the right

side of an active window. A
proportional scroll box Is the
white rectangle inside the
scroll bar.

Scrolling

The SYSTEM.DISK window isn't large enough 10 display ihe

complete directory of what's stored on the system disk. You scroll

to change the portion of the directory that's visible in the window.

The scroll bars represent the size of the complete directory. The
proportional scroll box within each scroll bar represents the

proportion of the entire directory that's displayed. (See

Figure 1-10.)

Scroll bar

Proportional scroll box

Figure 1-10

Scroll bars and proportional scroll boxes

Notice that the proportional scroll box in the horizontal scroll bar

in the SYSTEM.DISK window covers about half the gray portion of

the scroll bar. This indicates that about half the width of the

directory is visible. The proportional scroti box in the vertical

scroll bar completely covers the gray portion of the scroll bar,

indicating thai the entire length of the directory is in view.

14 Chapter 1: Trying Out the Finder



To scroll:

1. Drag Ih© proportional scroll box In the horizontal scroll bar all

the way to the right. (See Figure 1-11.)

Figure 1-11

Dragging the proportional scroll box

The right half of the directory is displayed.

2, Drag the proportional scroll box all the way to the left.

And you're back where you started.

The Finder provides several other ways to scroll. See "Scrolling in
Chapter 2 for details.

Using the zoom box

Another way to increase the view of a directory is to use a window's
zoom box to expand a window to its full size. The zoom box is the
small square in the top-righi corner of the window.

A hands-on tutorial 15



Zoom box

1. Position the pointer on the zoom box and click to make the

SYSTEM. DISK window occupy the whole screen. (See Figure

1-12.)

SVSTEHDISK

9 items 67IK used 129K available

PRODOS

APPLETALK

C
SYSffN

ICONS

SVS.UTILS

DIRLOG ICONS

M

U

Figure 1-12
Zooming

The window zooms qui to fill the screen.

2. Click the zoom box again.

"Hie window returns to its former size and position.

Changing your view

The directory in the SYSTEMDISK window is arranged by icon.

By using the commands in the View menu, you can examine the

directory of a disk or folder from several perspectives.

1. With the SYSTEM. DISK window displayed, choose By Name
from the View menu.

The contents of the window are arranged alphabetically by

name-

See "The View Menu" in Chapter 6 for details about each View

option.

2. Choose By Icon trom the View menu.

This returns you to the original airangemenl of the directory.

16 Chapter 1: Trying Out the Finder



An application Is a computer
program written (or some
specific purpose, such as
word processing, data base
management, or graphics.

Starting on application

To start an application, you simply open the icon that represents
it. The system disk, which contains the Finder, also contains an
application called the System Utilities. In this section, you'll start

the System Utilities.

Since the System Utilities program is inside a folder called

SYS.L'TTLS, you need to open that folder before you can start

the application.

1. Position the pointer on the SYS.UTILS folder Icon and quickly
press and release the mouse button twice. (See Figure 1-13.)

This action is called double-clicking. If you want to open an
icon, you can double-click it, or you can select the icon and
choose Open from the File menu, as you did earlier.

•File Edit View Special Color

SYSTmOISK^s

SYSTEM

CD CD
APPLE

7
D

IIRL06.IC0KS

'"': "
.';":':i-'

::-:WiJ
n

Figure 1-13
Opening a fofder

A hands-on tutorial 17



The SYS.UT1LS window now appears on top of the SYSTEM.DISK
window. (See Figure 1-14.)

• File Edit View Speciol Color

5Y5TA1.P1 SK

<£

1
SVS UTILS

671K used 129K

«

^T

Figure 1-14

The SYS.UTILS window

The SYS.UTILS window is now the active window because it is

the scene of the next action you perform. See "Making a Window
Active" in Chapter 2 For more information about active windows.

The icons you see in the SYS.UTILS window represent files thai

the System Utilities application needs in order to operate,

Open the System Utilities application by double-clicking the

SYSUTILSYSTEM Icon, or by selecting the Icon and choosing
Open from the File menu.
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After several seconds the Main Menu of the System Utilities

appears on ihe screen. (See Figure 1-15.)
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Figure 1-15

The Main Menu of the System Utilities

ProDQS, Pascal, and DOS 3.3

are operating systems used
by applications that run on
the Apple 1IGS. (An operating
system Is a program that
controls the way Information
travels between memory
and disk,) For more Informa-
tion on operating systems
used with computers In the
Apple II family, see the Apple
Hgs Owner's Guide.

Although the System Utilities and the Finder operate differently,

they perform many of the same tasks, such as copying files,

renaming Hies, and so on. A major difference between them is

that the Finder can be used only with ProDOS disks, whereas the

System Utilities can also be used with Pascal and DOS 3.3 disks.

3. Press Ihe Down Arrow key until Ihe Quit option is

highlighted. Then press the Return key.

4. When you see a message asking whether you want to quit
the Utilities, press Return.

After several seconds, ihe Finder desktop appears on the screen,

just as you left it.
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5. Close the SYS.UTILS window by clicking Its close box. (See
Figure 1-16.)

The close box is the small square in the top-left corner of Lhe

window.
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Figure 1-16

Closing a window

6, Close lhe SYSTEM.DISK window by clicking Irs close box.

When you Initialize a disk, you
divide It Into sections where
Information can be stored.

Initializing a disk

Your final task is to make a duplicate copy of the original system

disk. But before you can copy information onto a new disk, or onto

a disk thai has been used with an operating system other than

ProDOS, you must Initialize it.

1. Place the disk that will contain the copy of the system disk
In an empty 3.5-Inch drive.

If you have only one 3.5-inch drive, eject the system disk by
selecting the SYSTEM.DISK icon and choosing Eject from the

File menu. (Notice that the disk icon remains on the desktop after

the disk has been ejected.) Then insert the disk that will contain

the copy.
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If you've never used ihc disk before, you'll see the message
shown in Figure 1-17.

(

This disk is unreadable Do you want to

initialize it os a ProDOS disk'

Uect ] [ Initialize
J

Figure 1-17

Initializing a new disk

Click Initialize,

If the disk has been initialized already, bul for an operating
system other than ProDOS. you'll see the message shown in
Figure 1-18.

This disk wo? imtiolized for another

operating systea and can't be read by ProDOS.

Do you want to initialize it as a ProDOS disk?

( Eject j [initialize)

Figure 1-18
Initializing a disk that has been initialized for another operatinq
system

Ifyou don't want lo erase what's already on the disk, dick
EjecL 'Ihen insert another disk. If you want to erase what's
on the disk and initialize it as a ProDOS disk, click Initialize.

n If you don't see either of these messages, your disk has already
been initialized and you can go on to the next section,
"Making a Backup." If you want to give the disk a different

name, see "Renaming Icons" in Chapter 2.
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2. When you see a message asking you to name the disk, type

a name for the disk, such as SYSTEM.BACKUP, and click OK or

press Return.

You need noi press the Shift key while typing, the name; the letters

will appear as uppercase letters automatically.

The name you choose must have no more than 15 characters and

must begin with a letter. Subsequent characters may be letters,

numbers, or periods. If you type any other character, it won't be

displayed.

A backup disk is a duplicate

of a disk, Making a backup
copy of a disk Is like making
a photocopy of o paper docu-
ment. Use your backup copy
and put the original away for

safekeeping.

Making a backup

Now that you have an initialized disk on hand, you're ready to make

a backup copy of the system disk.

Before you begin, make sure the icon representing the system disk

and the icon representing the disk thai will be your backup copy arc

both visible on the desktop. (To place a 3. 5-inch disk icon on Jhe

desktop, simply insert the disk in a disk drive.)

1. To perform the copying procedure, drag the SYSTEM. DISK

Icon on lop of Ihe icon of the disk that will be the backup.

When you drag the SYSTEM.DISK icon on top or the backup disk

icon, don't release the mouse buiton until the backup disk icon is

highlighted. (See Figure 1-19.)
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Figure 1-19

Copying a disk

A dialog box Is a box con-
taining Information and. In

some cases, requesting o
response from you.

A block is a unit of measure
used to specify the saze of
disks and files. One block
equals approximately 512
characters. A 5.25-inch disk

contains 280 blocks. A 3.5-

Inch disk contains 160C
blocks

2. When you see the dialog box asking you to confirm thaf you
wanl lo replace everything on the newly initialized disk,

click OK.

Pressing Return has the same effect as clicking the button with a

double line around it in a dialog box; in this case, pressing
Return has the same effect as clicking OK.

As the copying proceeds, you'll see messages indicating how
many blocks are left to copy.

If you're using only one drive, the Finder periodically will display

messages telling you the name of the disk to insert. When a mes-
sage appears, eject the disk currently in the drive by pressing the

eject button on the front of the drive. (You won't be able to eject

the disk using the Eject command because this command is

deactivated during the copying procedure.) Then insert the disk

named in the dialog box and click OK.

If you see a message telling you that the Finder can't complete the

copying procedure, turn to Chapter 7, "Troubleshooting," for

tips on remedying the problem.
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By the way The procedure you have just used to copy a disk is

the same one you will use to copy any item from one place to

another: simply drag the icon that represents whatever you want

to copy—file, folder, or disk—on top of the icon that repre-

sents the folder or disk that will contain the copy.

Moving on
You've completed a detailed hands-on introduction to the Finder,

Now you're ready to organize your own desktop or to start an

application, IF you want to learn about a specific task, turn to

Chapters 2 through 5. If you want to know how a particular menu
command works, look it up in Chapter 6.

* By the way: The Preferences command in the Special menu lets

you control a number of Finder options to suit your needs. For

information about the Preferences command, sec "The Special

Menu" in Chapter 6.
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directory of a disk or folder

This chapter describes general procedures for using the Finder.

Many of these procedures can also be used wilh other mouse-based
applications.

This chapter explains how to

a manipulate windows so that you can set up your desktop to suit

your needs

a select one or more icons, to indicate where your next action will

take place

type and edit text so that you can provide information when
prompted by the Finder

rename icons so that you can give new names to files, folders,

and disk'

Manipulating windows
When using the Finder, you look at the content of disks and folders

A window Is an area on the through windows. (See Figure 2-1.) By placing a number of win-

%£SZ%?£ffiJ!Z dows °" *e **"R V°" cm view ihe content of several disk, or
folders simultaneously.

The windows you use with the Finder have these features:

a title bar

scroll bars

scroll arrows

proportional scroll boxes

a size box

a zoom box

D a close box

These features are explained in the following sections of this

chapter.
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Title bar _

Close box

Zoom box

Scroll bar

Size box -

Scroll arrow

'ERSOHflL
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CZl CD
LETTERS TRAVEL CD.COLLECTIQ

-

Figure 2-1

A window on the Finder desktop

Making a window active

Although you can have more than one window on the desktop, only

one window can be active. (See Figure 2-2) The active window is the

scene of the next action you perform and has these characteristics:

It appears in front of all other windows on the desktop,

Its title bar is highlighted with narrow horizontal lines on either

side of the title.

To make a window active, click anywhere in the window.

Activating a window brings it to the frontmost position on the

desktop, where it may overlap or completely cover other windows.

To make a covered window visible so that you can activate it, move
the active window or make it smaller.
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Inacflv© window

Acffve window
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Figure 2-2

An active window and an inactive window

Moving a window
To move a window:

1

,

Position [he pointer anywhere on the title bar of the window
except on the close box or on the zoom box.

2

.

Drag the window to a new location, (See Figure 2-3.)
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Moving a window

The window you are moving becomes [he active window, if it

wasn't already.

To cancel the move, drag the pointer into the menu bar.

By the way: To move an inactive window without activating it,

hold down the Apple key while you drag the window by its title

bar.

Changing the size of a window

To reduce or enlarge a window-

1

.

If the window isn't active, activate it by clicking anywhere inside

it.

2 . If necessary, move the window until the size box in the bottom-

right corner is visible.
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3 . Drag Lhc size box. CSee Figure 2-4.)
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Figure 2-4

Changing the size of a window

Dragging horizontally changes the window's width, dragging

vertically changes its height, and dragging diagonally changes

both. The new dimensions take effect wrhen you release the mouse

button,

By the way Clicking a window's zoom box expands the window

so that it occupies the whole screen. Clicking the zoom box of a

fully expanded window shrinks the window back to its original

size.

Closing a window

To close a window:

1 . If the window isn't active, activate i[ by clicking anywhere inside

it.
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A scroti bar Is a long bar at
the bottom or on the right

side of an active window A
proportional scroll box Js the
white rectangle Inside a
scroll bar.

Scroll bar

Proportional scroll box

2. Choose Close from the File menu or click the window's close

box. (See Figure 2-5.)
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Figure 2-5
Closing a window

Scrolling

You scroll to change the portion of a directory that's visible in a
window.

The scrollbars represent the size of the complete directory. The
proportional scroll boxes show how much of the director)'- is

visible in the window. (See Figure 2-6.)
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Figure 2-6

Scroll bars and proportional scroll boxes
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Figure 2-7

Scrolling

The proportional scroll box in the horizontal scroll bar shows how
much of the width of the directory is displayed.

The proportional scroll box in the vertical scroll bar shows how
much of the length of the directory is displayed.

When the proportional scroll boxes completely cover the gray

portions of the scroll bars, the entire directory is visible in the

window.

Scrolling a tine at a time

To scroll slowly, a line at a time, click the scroll arrow that points in

the direction of what you want to see, (See Figure 2-8.)
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Figure 2-8

Scrolling a line at a time

You can scroll continuously line by line if you position the pointer

on the scroll arrow and hold down the mouse button.

Scrolling by the windowful

To scroll one windowful of information at a time, click the gray area

of the scroll bar. (See Figure 2-9.)
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Scrolling by the windowful

You can scroll continuously by the windowful if you position the
pointer in the gray area of ihe scroll bar and hold down the mouse
button.

Scrolling quickly

To scroll quickly lo any pari of a directory, drag the proportional

scroll box to the point in the scroll bar that represents the approx-
imate position of what you want to see.

If the right side of a directory is displayed in a window and you want
to display the left side of the directory, for example, drag the

horizontal proportional scroll box lo the left side of the scroll bar.

(See Figure 2-10,)
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Figure 2-10
Scrolling quickly
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An Icon is a graphic repre-

sentation of an object,

concept, or message,
You select something to

designate where the next
action will take place.

Selecting icons

Before you can move, copy, rename, or remove an icon, you must

select it- (See Figure 2-11.)
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Figure 2-11
Selecting an icon

•> fly r7ie way.- Before you can select a 5.25-inch disk icon, y< u

must open the icon of the 525-inch disk drive that contains the

disk. When you open the disk drive icon, the 5.25-inch disk

icon is displayed on the desktop. See "Opening a Disk Icon or

a Disk Drive Icon™ in Chapter 3 for more information.

Selecting one icon

To select one icon, click anywhere on the icon. Clicking the icon's

name also selects the icon

Selecting more than one icon

It's often useful lo select two or more icons in order to move, copy,

or remove them as a group.

There are two techniques for selecting more than one icon—one for

icons thai are grouped together in a window or on the desktop, and

one for icons that are not.

To select icons that are grouped together;
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To Shift-click, hold down the
Shift key while you click the
Icon you want to select,

1

.

Position the pointer outside one corner of a group of icons.

2. Drag 10 the opposite corner. (See Figure 2-12.)

Figure 2-12
Selecting multiple Icons grouped together

To select icons that aren't grouped together:

3 . Select one icon by clicking it.

2. Shift-click to select each additional icon.

Deselecting icons

To deselect an icon that is selected, Shift-click the icon. To deselect

all selected icons, click any location on the desktop other than one
of the selected icons.

A few pointers

Mere are a few hints for selecting more than one icon:

I You can Shift-click the icon or the icon name to select more than

one item in directories that are arranged by text. (For more
information about viewing directories arranged by text, see "The
View Menu" in Chapter 6.)

] A quick way lo select all icons in the active window is to choose
Select All from the Special menu.
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G You can select more than one icon only when all the icons arc in

ihe same window or when they are all on the desktop.

A dialog box Is a box that
appears on the screen to

provide Information and. In

some cases, to request a
response from you

Selecting and editing text

When using the Finder, you will need to edit text or type new text

whenever you rename an icon or specify the name of a disk, folder,

or file in a dialog box.

Inserting text

To insert text:

1 . Click where you want to insert text.

The blinking vertical bar marks where the text you type will be

inserted. (See Figure 2-13.)
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Figure 2-13
Inserting text

To reposition the blinking vertical bar, use the Left Arrow key or

the Right Arrow key, or click at the new location.

2 . Type to add lext.
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Selecting text

To select text, position the pointer at the beginning or end of the

text you want to select, then drag across it (See Figure 2-14.)
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Figure 2-14
Selecting text

The text will be highlighted when it is selected.

To select a complete word, double-click it; position the pointer on
the word you want to select; then press and release the mouse button
twice in quick succession without moving the mouse.

Deleting text

To delete text:

1 . Select the text you want to delete.

2 . Press the Delete key or type Control-X.

By the way: The Control key is located on the left side of the

keyboard When you are asked to press two keys whose names
are joined by a hyphen, hold down the first key, then press the

second key.

You also can delete text using ihc following techniques:

D To delete the complete line of text, press Control X when no text

is selected.
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To delete the character to the left of the blinking vertical bar,

click to position the vertical bar-, then press Delete.

D To delete the character to the right of the blinking vertical bar,

click to position the blinking vertical bar; then press Conlrol-F.

D To delete all text to the right of the blinking vertical bar, click to

position the vertical bar-, then press Control-Y.

Replacing text

To replace text;

1

.

Select the text you want to replace.

2 . Type the new text.

Renaming icons

You can give a new name to a file, folder, or disk whenever its icon

is visible in a window or on the desktop. You cannot, however,
rename a file or folder that is locked or a disk that is write protected.
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Figure 2-15
Renaming an Icon
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A pathname is the complete
name of a file. It Includes the
name of the disk a file Is

stored on, followed by the
name of any folder (or of any
foldsrs within folders) the
file Is stored In, followed by
the file's name, For more
Information about path-
names, see "Using Folders* In

Chapter 4.

A disk directory Is a list of the
files and folders on a disk. The
disk directory does not
Include the names of files or

folders that have been
nested Inside other folders.

To rename an icon:

1

.

Select the icon that represents whai you want to rename and

choose Rename from the File menu. Or double-click the icon's

name. You can rename items that are viewed by text or by icon.

See "The View Menu" in Chapter 6 for a description of the

viewing options.

2 . When a box appears around the icon's name, type the new name
or edit the name that's there. Then press Return. To cancel the

renaming operation, press the Esc (Escape) key or click

anywhere outside the box.

Use names that will help you identify what you're naming.

When you rename an icon, keep the following rules in mind:

a Names can have no more than 15 characters.

The first character must be a letter,

Subsequent characters may be letters, numbers, or periods. IF

you type any other character, it won't be displayed,

D The icon's pathname cannot exceed 64 characters.

No two icons in the same folder or disk directory can have

the same name.

n No two disks on the desktop can have the same name.
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When you arc working with whole disks, you can use the Finder to

Q open a disk icon so that you can see what the disk contains

initialize a disk so that it can receive information

make a copy of all the information on a disk

n erase all the information on a disk

eject a disk from its disk drive

Opening a disk icon or a disk drive icon

You open a disk icon to display a window that contains a directory

of the disk's content.

LETTERS

JOHN ALICE

Figure 3-1

Opening a disk Icon

To open a disk icon, double-click the icon, or select the icon and

choose Open from the File menu.
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You can use the Finder to examine the content of any ProDOS disk,

rng 3-linduding a 5.25-inch disk, a 3.5-inch disk, a RAM disk, and
a hard disk. (If you have a memory expansion card connected to

your Apple IlGS
t
you can designate a portion of the memory on the

card to be used as a RAM disk, a temporary storage area for appli-

cations and data. See the Apple IIGS Owner's Guide for details.)

Figure 3-2 shows the icons used to represent each of these disks.
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Figure 3-2

Disk Icons

Notice that Figure 3-2 shows a 5.25-inch disk drive icon. If you have
a 5.25-inch disk drive connected to your Apple IIGS, the Finder
displays the drive icon even if there is no disk in the drive.

To examine the directory of a 5.25-inch disk, you must first open
the disk drive icon that represents the drive containing the disk,

Doubleclick ihe drive icon, or select it and choose Open from the
File menu. The 525-inch disk icon is then displayed, and you can
open ii in the usual fashion.

Opening o disk icon or a disk drive icon 43



By the way- If you are using a disk or a 5.25-inch disk drive

whose icon is noi displayed on the desktop, check to make sure

that the disk drive is connecied to your Apple IIGS and thai the

disk is properly positioned in the drive. If the icon still isn't

displayed, use the Control Panel to activate the slot associated

with the drive that contains the disk; then restart your com-

puter. See the Apple JIGS Owner's Guide for instructions on

using the Control Panel.

Figure 3-3

Initializing a disk

Initializing disks

Before you can save information on a disk, Unc disk must be

Initialized or formatted. (These terms are used interchangeably.)

Initializing a disk divides it into numbered "parking spaces" where

information can be stored and retrieved. Initializing also sets up a

directory—a table of contents of sorts—that contains key informa-

tion about the content of the disk. Each of the operating systems

available on the Apple 1IGS—ProDOS. DOS 3.3, and Pascal-

creates a different kind of directory. That's why, for example, you

can't store a DOS 3.3-based application on a disk formatted for

ProDOS,

There are two occasions when you will use the Finder to initialize a

disk:

z when a disk has never been used before and you want to use it with

a ProDOS-based application

u when you have initialized a disk so it can be used with a Pascal* or

DOS 3.3-based application and you now want to erase what's on

the disk and use it with a ProDOS-based application

Important You can use the Finder to Initialize disks in the ProDOS format

only. If you want to Initialize disks in the Pascal format you'll

need to use the System Utilities described In Part 2 of this

manual. To start the System Utilities, open the SYSUTIL.SYSTEM

file in the SYS.UTILS folder on the system disk.
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By the way.- Before you begin using an application, check in the
owner's manual For the program to find out whether the appli-

cation initializes disks. If it doesn't, use the Finder to initialize

several disks before using the application. (You'll lose the docu-
ment stored in the computer's memory if you don't have an
initialized disk on hand when you're ready to save your work.)

To initialize a disk:

1
.
Insert the disk you wanl to initialize in a disk drive. Tf it is a 5.25-

inch disk, open the 5.25-inch disk drive icon.

If the disk has never been initialized, you'll see the message in

Figure 3-4.

This disk is unreadable Do you want tc

initialize it as a ProDOS disk7

[ Eject J ( Initialize]

Figure 3-4

Initializing a new disk

Click initialize unless you will be using the disk with an
application that doesn't use ProDOS.

If the disk has already been initialized, but as a DOS 33,
Pascal, or Macintosh™ disk, you'll see the message in
Figure 3-5.

This disk was initialized for another

operating system and can't be read by ProDOS.

Do you want to initialize it as a ProDOS disk'

[ Ejtct ] [ Initialize]

Figure 3-5
Initializing a disk that has been initialized for another
operating system
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Figure 3-6

The benefit of backing up

The default option is the
option that the Finder uses
unless you give It other
Instructions.

A block Is a unit of measure
used to specify the size of
disks and files. One block
equals approximately 512
characters. A 5.25-Inch disk

contains 280 blocks. A 3.5-

Inch disk contains 1600
blocks.

If you don'i want to erase what's already on the disk, click

Eject. If you want to erase what's on the disk and initialize it as a

ProDOS disk, click Initialize.

•> By the way: You can use the Catalog a Disk option in the

System Utilities lo identify the content of a DOS 3.3 disk or of a

Pascal disk. For information on this option, see "Cataloging a

Disk" in Chapter 11.

2. Before the Finder initializes the disk, you'll be asked to name it.

Type a name and click OK,

See "Renaming Icons" in Chapter 2 for guidelines on naming
disks.

Copying disks

Making backup copies of disks is the best way to protect your work.

When you make a backup copy, you copy the information on the

source disk—the disk you're making a copy of—to the destination

disk—the disk that will contain the new copy.

The Finder gives you several options when copying disks. The
default option differs depending on whether you're copying disks

of the same size or disks of different sizes. If you copy a 3- 5-inch disk

onto another 35-inch disk, for example, you are copying disks of

the same size. If you copy a 5.25-inch disk onto a hard disk, you are

copying disks of different sizes. A disk's size is measured in blocks.

This section describes each of the Finder's disk-copying options.

o "Copying Disks of the Same Size" describes the default option

used by the Finder when, copying disks of the same size.

"Copying Disks of Different Sizes" describes the default option

used by the Finder when copying disks of different sizes.

i i "Other Copying Options" describes copying options in addition

to the default options-
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Copying disks of the some size

When you're copying disks of the same size, the default option is to

replace the content of the destination disk with the content of the

source disk.

•> By the way The Finder doesn't allow you to have two disks with
the same name on the desktop at the same time. Consequently,
when you copy the content of the source disk onto the destination

disk, the destination disk keeps its original name. If you want trie

destination disk to have the same name as the source disk, eject

the source disk after the copying procedure is complete. Then
rename the destination disk icon.

To copy disks of the same size, follow these steps:

1 . Insert both the source disk and the destination disk.

*> One-drive users: If you're using only one disk drive, both
the source disk icon and the destination disk icon must be
displayed on the desktop before you can begin the copying
procedure.

To display both disk icons on the desktop when you're using
a 3.5-inch disk drive, insert the source disk; then eject the
source disk by choosing Eject from the Special menu, and
insert the destination disk.

To display both disk icons on the desktop when you're using a
5.25-inch disk drive, insert the source disk and open the 5. 25-

inch disk drive icon so that the disk icon is displayed. Then
open the disk drive door and remove the source disk. Next,
insert the destination disk and open the 5.25-inch disk drive
icon so that the destination disk icon is displayed.
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2, When the source disk and destination disk icons are displayed,

drag the source disk icon on lop of the destination disk icon. (5ee

Figure 3-7.)

Figure 3-7

Copying disks of the same size

You can also drag Che source disk icon into the destination disk

window.

You'll see a message asking you to confirm that you want to erase

everything on the destination disk and replace it with what's on

the source disk. Click OK to continue, click Cancel to stop the

copying procedure.

As the copying procedure continues, you'll see messages

indicating how many blocks are left to copy,

If you want to slop the copying procedure while it's in progress,

press any key. A dialog box appears asking you to confirm that

you want to stop the procedure.

Chapter 3: Working With Disks



Warning The destination disk Isn't usable until the copying procedure
Is complete. When doing a block-by-block copy, the Finder
erases all the Information on the destination disk before it starts

copying. During the copying procedure, the Finder copies
Information a block at a time instead of a file at a time, so that
Information in a single file Isn't necessarily copied as a unit.

If you see a message telling you that the Finder can't complete the

copying procedure, turn to Chapter 7, "Troubleshooting," for

tips on remedying the problem.

One-drive users. If you're using only one disk drive, the Finder
periodically displays a dialog box telling you the name of the

disk to Insert

If you're using a 3. 5-inch disk drive, eject the disk currently in

the drive by pressing the eject button on the front of the drive.

(You won't be able to eject the disk using the Eject command
because this command is deactivated during the copying
procedure) Then insert the disk named in the dialog box and
click OK or press Return.

If you're using a 5.25-inch disk drive, open the disk drive door
and remove the disk currently in the drive. Then insert the disk
named in the dialog box and dick OK or press Return.

Copying disks of different sizes

When you're copying disks of different sizes, the default option is to

place the content of the source disk in a folder on the destination
disk. The folder will have the same name as the source disk.

RAM disk users: When using the Finder with a RAM disk, you
should set the minimum and maximum RAM disk sizes in the
Control Panel to the same value. If you have not done so, a
system error may occur when you try to copy a disk onto the RAM
disk. For information on using the Control Panel to set RAM disk

size, refer to the Apple lies Owner's Guide.

To copy disks of different sizes, follow these steps:

1
.
Insert both the source disk and the destination disk.
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2, Drag the source disk icon on top of the destination disk icon,

(See Figure 3-8.)

BOB TED

—

CAROL

f— ~ ~ ~>

'BUSINESS!

<->
,10,

SOURCE DESTINATION
DISK DISK

Figure 3-8

Copying disks of different sizes

You can also drag the source disk icon into the destination disk

window.

You'll see a dialog box asking you lo confirm that you want to

place the content of the source disk in a folder on the destination

disk. Click OK to begin the copying procedure. Click Cancel to

slop.

II' you want to slop the copying procedure while it's in progress,

press any key. A dialog box will appear asking you to confirm that

you want to slop the copying procedure. If you stop, the files and

folders lhat have already been copied will be in a folder on the

destination disk.

If you see a message telling you that the Finder can't complete the

copying procedure, turn to Chapter 7, "Troubleshooting," for

tips on remedying the problem.
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Other copying options

The Finder gives you options other than the default options. To
select one of these options, follow these steps:

1

,

Insert bolh the source disk and the destination disk.

If you're using only one disk drive, see the instructions in

"Copying Disks of the Same Size" above.

2. When the source disk and destination disk icons are displayed,

hold down die Option key and drag the source disk icon on top of

the destination disk icon or into the destination disk window.

3 - Choose an option from the Disk Copy Alternatives dialog box
shown in Figure 3-9,

Bisk CoDd DHfrnotives

O Place the contents of "PERSONAL" in a folde- : PERSONAL"

(§) Completely replace the contents of "BiV

of "PERSONAL".

id the contents of "PERSOHBL" to the contents of "BACKUP PERSOHflL"

( Concel J L_0K_

Figure 3-9

The Disk Copy Alternatives dialog box

To place the content of the source disk in a folder on the

destination disk, click the first button and then click OK. This

option is the default when copying disks of different sizes. See

the preceding section/'Copying Disks of Different Sizes," for

more information.

To replace the content of the destination disk with the content

of the source disk, click the second button and then click OK.
This option is the default when copying disks of the same size.

See "Copying Disks of the Same Size" above for more infor-

mation.
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To place the content of the source disk on trie destination

disk without placing ihe copied items in a folder and without

erasing the content of the destination disk, click the third

button and then click OK.

I
. ou choose the third option in the Disk Copy Alternatives

dialog box and the Finder tries to copy an item when the

destination disk directory already contains a file or folder with

that item's name, you'll sec the dialog box in Figure 3-10.

Fjafl The file/folder "REX "already

_JH exists.

(( Don't replace this item U

C Replace this i ten 1

t Don't replace any duplicate iteas. )

( Replace all duplicate items. )

[ Cancel

Figure 3-10
The Finder encounters a duplicate item

i If you don't want die Finder to replace the file or folder in the

destination disk directory with the file or folder being copied,

dick the "Don't replace thi.s item" button.

If you want die Finder to replace the file or folder in the

destination disk directory with the item being copied, click

the "Replace this item" button.

i If you don't want the Hinder to replace any items in the des-

ination disk directory that have the same names as files or

folders being copied, click the "Don't replace any duplicate

items™ button. The dialog box will, not appear again during

the copying procedure.
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If you want the Finder lo replace all items in the destination

disk directory that have the same names as items being

copied, click the "Replace all duplicate items'* button. The

dialog box will not appear again during the copying

procedure.

a Click Cancel lo slop the copying procedure.

You'll see the dialog box shown in Figure 3-1 1 if the Finder tries

to copy an item that has the same name as one of the following

items in the destination disk directory:

n a locked file

a locked folder

lj an unlocked folder that contains a locked item

The file/folder "TRAVEL" already exists and is

locked (or contains items that are locked).

Replace it anyway 7

Cancel Cj«D

Figure 3-11

The Finder encounters a locked duplicate item

If you want lo replace ihe item in the destination disk directory, click

Yes. If you don't want lo replace the item but want the Finder to

continue with the copying procedure, click No. To cancel the

copying procedure, click Cancel.
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Erasing disks

Erasing a disk is like erasing a blackboard. Everything vanishes, and
you're left with a blank slate

f
ci V

•=-

^ —j

\_ji: i,

Figure 3-12
Erasing a disk

You erase a disk when you want [o delete the information on it 1 m
don't need to reinitialize it for use wilh a different operating system.
You initialize a disk when it's brand new or when you want to

reinitialize it for use wilh a different operating system.

To erase a disk:

1 . Select the icon that represents the disk you want to erase.

2
.
Choose Erase from the Special menu.

You'll sec a dialog box asking you to confirm that you want to erase

the disk. If you do, click OK. Otherwise, click Cancel

54 Chapter 3: Working With Disks



^k

Ejecting disks

There arc iwo occasions when you'll want to age the Finder to eject

disks:

when you no longer need to use the di.sk

] when you're pying a file, folder, or disk with only one disk

drive

Ejecting a disk you no longer need

To eject a disk you no longer need:

] . Select trie icon that represents the disk you want to eject.

2. Drag the selected icon into the Trash. If you're electing a 5.25-

inch disk, you'll need to open the disk drive door and remove the

disk.

For advanced users When you eject a disk, the Finder places a

FINDER.ROOT file in the directory of the disk. This file tells the

Finder which windows 10 open the next lime the disk icon is

placed on the desktop. The Finder also creates a F1NDER.DATA
file for each window on the desktop thai tells the Finder the size

and position of Che window and the position and color of each
icon in the window.

If you want the Finder co eject trie disk more quickly, you can
change the default option so that the Finder doesn't create

FINDFR.ROOT and FJNDFR.DATA files when you eject a disk.

Choose Preferences from the Special menu and turn off the

Save Finder Information onto disk" option.

If you hold down the Option key while you drag a disk icon inio

the Trash, the Finder does ihc opposite of what is specified in the

fences menu. For example, if the "Save Finder information

onto disk
1

' Option is turned on and you hold down the Option key
while dragging a disk icon into the Trash, the Finder won't save
the Finder Information onto disk.
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Ejecting a disk when copying with only one drive

When copying a file, folder, or disk with only one disk drive, you

must place both Lhc source disk icon and the destination disk icon

on the desktop before you can begin the copying procedure. To do

this, insert the source or destination disk; next, eject the disk but

leave its icon on the desktop; then insert the other disk.

To eject a 3.5-inch disk while leaving the disk icon on the desktop,

follow these steps:

1 . Select the disk icon you want to eject.

2, Choose Eject from the Special menu.

The disk will be ejected and the disk icon will be dimmed.

You also can eject the disk by pressing the eject button on the disk

drive.

To eject a 5.25-inch disk while leaving the disk icon on the desktop,

follow these steps:

1 . If you haven't already done so, open die 5.25-inch disk drive

icon. The disk icon thai represents the disk in the drive will be

displayed

2. Open the disk drive door and remove the disk. The disk icon will

not be dimmed.

See "Copying Disks" in this chapter and "Moving and Copying

Items Onto a Different Disk" in Chapter 4 for instructions on

copying with one disk drive.
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Chapter 4

Working With Files and Folders
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CURRENCY

Figure 4-1

Folders store related

documents

You can use the Finder to perform these tasks with files and folders:

place related files into folders

a move and copy files and folders

remove files and folders you no longer need

z lock files and folders so that you don't accidentally remove,

replace, or rename them

unlock files and folders when they no longer need to be protected

Using folders

Folders give you a way of organizing information on disks. You
might have one folder where you keep correspondence, another

where you keep poetry, and a third where you keep financial

records. You also can create folders within folders. In the folder

containing financial records, for example, you might have one
folder for tax records, another for budgets, and a third for your

stock portfolio.

Putting files in desktop folders is like putting paper documents in file

folders: it focuses your attention on a subset of information so you

don't have to search through everything on a disk to find the docu-

ments you need.

A pathname is the complete name of a file. It includes the name of

rite disk a file is stored on, followed by the name of any folder (or of

any folders within folders) the file is stored in, followed by the Tile's

name.

The pathname /SPORTS/HOISSFKACING/SECRETAK1A I

,

example, indicates that SECRETARIAT is a file in a folder called

IIORSF.RACIN'G on a disk called SPORTS,
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Figure 4-2

A pathname

In some Apple JIGS applications, you may encounter the term

subdirectory. A subdirectory and a folder are exactly ihe same
thing. For more information on subdirectories and pathnames,

see "Opening a Subdirectory
1

' and "ProDOS Pathname," both

in Chapter 8.

Creating a new folder

Before you can put information in a folder, you need to create the

folder. Here's how:

1

.

Open the icon thai represents Lhe disk iliac will contain the new
folder. To place a new folder inside an existing folder, open the

icon of the folder that will contain the new folder,

2 . Choose New Folder from the File menu.
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A folder called UNTITLED appears in the active window. If

there is already a folder named UNTITLED, the new folder

will be called L'NTITLED.A. This process continues until the

Finder reaches UNTITLED.Z. If all possible names through

UNTTTLED.Z are taken, the Finder cannot create any more

new folders.

If you want to rename the folder, select it and choose Rename
from the File menu, or double-click the folder's name.

Type a new name for the folder or edit the name that's displayed.

Then press Return,

The name must have no more than 15 characters, and the first

character must be a letter. Subsequent characters can be letters,

numbers, or periods.

fr By the way: The maximum length of a pathname is 64

characters. If you will be nesting several folders inside the

folder you just created, you should make the name of each

folder as short as possible.

Opening a folder

To open a folder, double-click the folder icon or select the icon and

choose Open from the File menu A window appears that displays a

directory of icons representing the content of the folder. (See

Figure 4-3.)
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When you move a file or
folder, you transfer It to a
different folder or onto a
different disk. When you
copy a file or folder, you keep
the original In Its current
location and create a dup-
licate.

A disk directory Is a list of the
files and folders on a disk. The
disk directory does not
Include files or folders that
have been nested inside
other folders.
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Figure 4-3

An open folder

Moving and copying files and folders

The Finder gives you several alternatives when moving and
copying items (files or folders).

c You can copy an item and place the copy in the same folder or
disk directory as the original. Use this procedure when you
need two copies of an item, an original and a version that you
want to modify.

You can move an item into a folder on the same disk as the

original. This procedure allows you to organize information
by grouping related materials in a folder.

You can move an item onto a different disk.

You can copy an item onto a different disk. This gives you a

backup copy of the item in case you damage the disk that contains

the original or inadvertently modify the original.
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Throughout the explanations of moving and copying, the following

terms are used:

The source disk and the sourcefolder contain the items you wanl to

rnovi or cop}

The destination disk and the destination folder are the disk and

folder to which you will be copying or moving items.

Table 4-1 is a brief summary of the moving and copying operations.

Table 4-1

Moving and copying summary

II you want to... Follow flhte procedure

Place a copy of an item

in the same folder or disk

directory as the original

item

Move an item into a

folder on trie same disk

as the original item

Move an item onto a

different disk

Copy an item onto a

different disk

Select the icon that represents the

item you want to copy, then choose

Duplicate from the File menu.

Whenever the dialog box appears,

name the duplicaie and click OK.

Drag the icon that represents the item

you want to move on top of the icon

thai represents the destination

Fi UdeJ

Drag the icon that represents the item

you want to move on top of the icon

that represents the destination disk or

destination folder. Then drag the

icon that represents the original item

into the Trash,

Drag the icon that represents the item

you want to copy on top of the icon

that represents the destination disk or

destination folder.

Complete instructions for these procedures are given in the

following sections.
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Important You can use the Finder fo move or copy files or folders onto
ProDOS disks only. If you want to move or copy files or folders

onto Pascal or DOS 3.3 disks, you'll need to use the System
Utilities, described in Part 2, To start the System Utilities, open
the SYSUTIL.SYSTEM file In the SYS.UTILS folder on the system disk.

See "Copying Disks" in Chapter 3 for instructions on making backup
iojul'.s of whole disks.

The default name is the
name the Finder provides
unless you specify some
other name.

Copying items into the same folder or disk

directory

When you want to alter a copy of an item while leaving the original

unchanged (as you would with a form letter), it is often useful to

copy the item into the same folder or disk directory as the original.

To make copies of files or folders and place the copies in the same
folder or disk directory as the originals:

! . Select the icons that represent the items you want to copy.

2. Choose Duplicate from the File menu.

You'll see a dialog box showing the default name of the

duplicate of the first item you selected.

3 . If you like, type a different name for the duplicate or edit the

name that's displayed in the dialog box. To cancel the

duplicating operation, click Cancel.

See "Selecting and Editing Text" in Chapter 2 for editing

instructions,

4 Click OK. If you selected more than one item to duplicate and
you want to skip to the next item without duplicating this one,

click the Skip File button.

5. If you selected more than one item to duplicate, a dialog box will

appear showing the default name of the duplicate of the next item

you selected. Repeal Sieps 3 and 4 for each selected item.
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*** By the way: To cancel the duplicating operation while it's in

progress, press any key. A dialog box appears asking whether you

want 10 cancel the operation. If you click Yes, the folder or disk

directory will contain any duplicate copies that were made before

you canceled Ihe operation.

If you see a dialog box slating that ihe Finder can't complete the

operation, turn to Chapter 7, "Troubleshooting," for tips on
remedying the problem.

Moving and copying items into a folder or onto a
different disk

This section explains the options available when moving items to a
folder on the same disk or when moving or copying items to a

different disk.

Moving items into o folder on the some disk

A useful organizational technique is to move files that contain

related information into the same folder. You can take your
organization one step further by placing folders within folders

as well

To move files or folders inside a folder on the same disk:

1

.

If you haven't already done so, insert the source disk and open
the necessary disk and folder icons so thai ihe icons of the files

and folders you want to move are displayed.

2. Make sure ihe destination folder icon or destination folder

window is displayed.

3 .
Drag the icons of the items you want to move on lop of the

destination folder icon or into the destination folder's window,
as shown in Figure 4-4.
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Figure 4-4
Dragging an item Into a folder's window

If you're dragging items on lop of a folder icon, don't release ihe
mouse buuon until the destination folder icon is highlighted.
The highlighting tells you that the items you're moving will be
placed inside the folder.

4 If the destination folder contains an item with the same name as
an item you're moving, you'll sec the dialog box in Figure 4-5,

The file/folder "I

exists

olreoi

Don'l replace this item

C Replace this item J

I Oon't replace gnu duplicate items~")

t Replace oil duplicate items )

[ Cancel ")

Figure 4-5
The Finder encounters a duplicate item
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Choose an option-

If you don't want the Finder to replace the item in the

destination folder with the item being moved, click the

"Don't replace this item" button.

a If you want the Finder to replace the item in the destination

folder with the item being moved, click the "Replace this

item" bullon.

If you don't want the Finder to replace any items in the

destination folder that have the same names as items being

moved, click the "Don't replace any duplicate items" button.

The dialog box will not appear again during the moving

procedure.

If you want the Finder to replace all items in the destination

folder that have the same names as items being moved, click

the "Replace all duplicate items" button. The dialog box will

not appear again during the moving procedure.

If you want to cancel the moving procedure, click Cancel.

5. You'll see the message shown in Figure 4-6 if an item you're trying

to move has [he same name as one of the following items in the

destination folder;

a locked file

n a locked folder

n an unlocked folder that contains a locked item

The file/folder "BOB " alreody exists ond is

locked (or contains items that are locked)

Replace it answos?

[ Cancel ) ( Ho ) f Ves ]

Figure 4-6
The Finder encounters a locked duplicate item
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If you want to replace the item in the destination folder, click

Yes. If you don't want to replace the item but want the Finder 10

continue the moving procedure, click No. To cancel the moving

procedure, click Cancel.

By the way: To cancel the move while it's in progress, press any

key. A dialog box appears asking whether you want to cancel the

operation. If you click Yes, the destination folder will contain

those items that the Finder moved before you canceled the

procedure.

If you see a dialog box stating that the Finder can't complete

the move, turn to Chapter 7, "Troubleshooting," for tips on
remedying the problem.

Moving and copying items onto a different disk

When you copy items onto another disk, you can copy them into

the disk directory or into a folder on the disk. If you want to move
the items rather than copy them, simply remove the original items

from your source disk after the copying procedure is complete.

RAM disk users: When using the Finder with a RAM disk, you

should set the minimum and maximum RAM disk sizes in the

Control Panel to the same value. If you have not done so, a

system error may occur when you try to move or copy items

onto the RAM disk. For information on using the Control Panel

to set RAM disk size, refer to the Apple UGS Owner's Guide.

To move and copy items onto a different disk:

1

,

If you haven't already done so, insert the destination disk. If

you're copying the items into a folder, open the icons necessary

to display the folder. If you want to copy the items into a disk

directory window or a folder window, display the appropriate

window.

2

.

If you haven't already done so, insert the source disk and open
any necessary icons so that the icons of the files and folders you
want to copy are displayed
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One-drive users. If you're moving or copying items with one

disk drive, the icons representing both the items you want to

copy and the destination folder or the destination disk must be

displayed before you can begin the copying operation.

If you're using a 3. 5-inch disk drive, insert the destination

disk, open any necessary icons, and eject ihe destination disk

by choqsing Eject from the Special menu; then insert the

source disk and open any necessary icons.

If you're using a 5,25-inch disk drive, insert the destination

disk, open the 5.25-inch disk drive icon so that the disk icon is

displayed, and open any necessary icons. Next, remove the

destination disk. Then insert the source disk, open the 5.25-

inch disk drive icon so that the source disk icon is displayed,

and open any necessary icons.

Drag the icons of the items you want to copy on top of the icon

that represents the destination disk or destination folder, as

shown in Figure 4-7.

• File Edit View Special Color

3 items

;hal

323Kused M77K awoilablD D D
LETTERS y TRAVEL CD COLLECT I0H

Figure 4-7

Dragging an item onto a different dEsk
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When you drag the items being copied, don't release the mouse
button until ihe destination disk icon or destination folder icon is

highlighted. The highlighting tells you that the icons you're

copying will be placed inside the destination disk or folder.

You also can drag the icons into a disk directory window or a.

folder window.

One-drive users.- If you're using only one drive, the Finder

periodically displays a dialog box telling you the name of the

disk to insert

ir you're using a 3-5-inch disk drive, eject the disk currently in

the drive by pressing the eject button on the front of the drive.

(You won't be able to eject the disk using the Eject command
because this command is deactivated during the copying
procedure.) Then insert the disk named in the dialog box and
click OK or press Return.

If you're using a 5.25-inch disk drive, open the disk drive door
and remove the disk currently in the drive. Then insert the disk

named in the dialog box and click OK or press Return.

If the Finder tries to copy an item into a folder or a disk directory

that contains an item with the same name, you'll see the dialog

box in Figure 4-8,

m The file/folder "BOB" already

easts

a Don't replace this item. X

t Replace this item

( Don't replace any duplicate items 1

(_ Replace oil duplicate items )

[ Cancel )

Figure 4-8
The Finder encounters a duplicate Item
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Choose an option;

u If you don't want the Finder to replace the item in the

destination folder or the destination disk directory- with the

item being copied, click the "Don't replace this item" button.

If you wanl the Finder to replace the item in the destination

folder or destination disk directory with the item being

copied, click the "Replace ihis item" button.

If you don't wanl the Finder to replace any items in the

destination folder or destination disk directory thai have the

same names as items being copied, click the "Don't replace

any duplicate items" button. The dialog box will not appear

again during the copying procedure.

D If you want the Finder to replace all items in the destination

folder or the destination disk directory that have the same

names as Items being copied, click the "Replace all duplicate

items" button. The dialog box will not appear again during the

copying procedure.

If you want to cancel the copying procedure, click Cancel.

5- You'U sec the message shown in Figure 4-9 if an item you're trying

10 copy has the same name as one of the following items in the

destination folder or the destination disk directory:

n a locked file

a locked folder

_ an unlocked folder that contains a locked item

m The file/folder "BOB " already exists and is

locked (or contains items that ore locked).

Replace tt angway?

1 :oncel ] ([~ Ho
1 (

Ves )

Figure 4-9

The Finder encounters a locked duplicate item
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If you want to replace the item in the destination folder or

destination disk directory, click Yes. If you don't want to replace

the item but want the Finder to continue the copying procedure,

click No. To cancel the copying procedure, click Cancel.

6. If you are moving items rather than copying them, drag the

original items, which are still on your source disk, into the Trash.

Then select Empty Trash from the Special menu.

By the way: To cancel the copying procedure while it's in

progress, press any key. A dialog box appears asking you to

confirm that you want to stop the operation. If you click Yes, the

destination disk or destination folder will contain the items that

were copied before you canceled the operation.

If you see a message telling you that the Finder can't complete the

copying procedure, turn to Chapter 7, "Troubleshooting," for

tips on remedying the problem.

Other moving and copying options

Normally, when moving or copying items, the Finder displays the

dialog box shown in Figure 4-10 the first lime it finds an item in the

destination folder or the destination disk directory" thai has the

same name as an item you're moving or copying. If you wish, you
can give the Finder instructions for handling duplicate files and
folders before you begin the copying or moving procedure.

To do so, hold down the Option key while dragging the icons that

represent the items you want to move or copy on top of the desti-

nation disk icon or destination folder icon. You can also drag the

icons you want to move or copy into a disk directory window or a

folder window.
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You'll see the File Copy Alternatives dialog box shown in

Figure 4-10.

FiU CopM Rlternatives

Replace items cose bqcase

( Don't fgplote on»j duplicote itetris )

( Replace all duplicate items )

f Cancel )

Figure 4-10

The File Copy Alternatives dialog box

Choose an option:

J If you want the Finder to prompt you each time it finds an item

in the destination disk directory or the destination folder that

has the same name as an item being moved or copied, click the

"Replace items case by case" button. This is the option the

Finder chooses if you don't specify otherwise.

a If you don't want the Finder to replace any items in the desti-

nation disk directory or the destination folder [hat have the same

names as items being moved or copied, click the "Don't replace

any duplicate items" button.

If you want the Finder to replace all items in the destination disk

directory or the destination folder that have the same names as

items being moved or copied, click the "Replace all duplicate

items'* button.

If you want to cancel the copying operation, click Cancel.
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Figure 4- It

Discarding files and folders

Discarding and recovering files and folders

The Finder lets you discard a file or folder whenever its icon is

visible on ihc desktop. You can remove a file or folder by dragging
its icon into the Trash, or by selecting the icon and then choosing
the Remove command from the Special menu. When you drag an
icon into the Trash, the Finder may not immediately free up the disk

space that the file or folder occupies. When you use the Remove
command, the Finder frees up the disk space immediately.

Discording files and folders into the Trash

To remove a file or folder using the Trash:

1
.
If necessary, open the folder or disk that contains the items you
want to remove.

2 Drag the icons of the items you want to remove on top of the

Trash icon or into the Trash window. The Trash icon will expand
lo show that the Trash is no longer empty.

3 If you want to remove the files or folders in the Trash and free up
i he space \\ic\ occupy on the disk, choose Empty Trash from the

Special menu, The Trash icon will return to its original size.

If you don't choose Empty Trash, the Finder will delete the

content of the Trash at its convenience.

Note: There's no way to predict precisely when the Finder will

empty the Trash, There are, however, certain events lhat ensure
immediate disposal, such as opening an application, copying
Files, opening any directory window, and ejecting the disk that

contained the icon. If you change your mind after discarding a
file or folder, don't waste any time retrieving it from the Trash.
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Recovering files and folders from the Trash

You can recover a file or folder from the Trash as long as its icon is

visible in the Trash window. To recover items from the Trash:

1 Open the Trash icon by double-clicking it, or by selecting it and

choosing Open from the File menu.

If necessary, scroll until you see the icon that represents what you

want to recover,

2 . Drag the icon out of the Trash window and onto the desktop or

into another window. If you want to restore the icon to its

previous position but can't remember where on the desktop it was

located, choose Put Back from the File menu after selecting the

icon.

Discarding files and folders using the Remove
command
To discard a file or folder using the Remove command:

1

.

If necessary, open the folder or disk that contains the items you

want to remove.

2. Select the icons of the items you want to remove.

3. Choose Remove from the Special menu,

You will see a dialog box asking whether you really want lo

remove the selected items.

4

.

Click OK to remove the items; click Cancel to discontinue the

operation,

By the way: If you don't want the Finder to display a dialog

box each time you choose the Remove command, choose

Preferences from the Special menu and turn off the "Double-

check before removing files and folders" option.
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Locking and unlocking files and folders

Locking a file or folder ensures that you don't accidentally re-

move, replace, or rename it. Unlocking a file or folder removes

this protection.

r

/

JH
Figure 4-12
Locking a fils

/
J ' c

JO
Figure 4-1

3

Unlocking a file

If you iry to put a locked file or folder in the Trash, delete it using the

Remove command, or replace it during a copying operation, the

Finder displays a dialog box asking you to confirm your decision.

If you try to rename a locked file or folder, the Finder docs not

respond.
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Locking files and folders

To lock a file or folder:

1

.

Select the icon that represents the file or folder you want to lock.

2. Choose Get Info from the File menu.

3- Click the Locked check box. An X appears.

4 , Close the Get Info window,

Unlocking files and folders

To unlock a locked file or folder:

1

.

Select the icon that represents the file or folder you want to

unlock.

2. Choose Get Info from the File menu.

3. Click the Locked check box. The X disappears.

A . Close the Gel Info window.
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One of ihe most important tasks you'll perform with the Finder is

An application is a program starting applications,
designed for a particular

purpose such as home When you start applications from the Finder, it's easy to switch from

finance, education, or word one application to another and to use the Finder's file and disk-
p

'
**'

handling capabilities to keep track of the documenls you create with

each application.

Say you're the president of your homeowners' association. You
want to use die Apple 11GS to write up the minutes of the annual

meeting and to prepare an invitation to die association's upcoming

picnic. Here's how you might use the Finder to maximize your

efficiency:

Start up the Finder.

h From the Finder, start up a word processing application and use

it to write the minutes of the annual mccung.

D Exit the word processing application and return to the Finder.

Use the Finder to make a backup copy of the minutes on another

disk.

From the Finder, start up a graphics application and use it to

create the picnic invitation.

!
I Exit the graphics applications and return to the Finder. Use the

Finder to place a backup copy of the invitation on die same disk

as the backup copy of die minutes.

Keep in mind that some applications include the Finder on the

same disk as the application. If that's the case, you won't need to

use the svstem disk at all.

Important If the application you're using is DOS 3.3-based or Pascal-

based, you can"t use the Finder to start it. Instead, start it

using the startup disk that came with the application. If you
don't know what operating system an application uses, check
the manual that accompanied the application, You also can
use the Catalog a Disk option in the System Utilities to identify

a disk's operating system. For Information on this option, see
"Cataloging a Disk" in Chapter 11,
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Starting an application from an application
icon

'Hie simplest way to start an application is lo open the icon lhat

repre.se nts it by double-clicking the icon, or by selecting it and
choosing Open from the File menu

Starting an application from a document
icon

You can sometimes start an application by opening an icon Lhat

represents a document created with the application. Double-click
the document icon, or select it and choose Open from the File

menu.

It the disk containing the application used to create (he document
is not in one of your disk drives, or is in a 5.25-inch disk drive
whose icon has not been opened, you'll sec the message shown in

Figure 5-1.

ID
The ODDlicotion *'MV.ftPPL [CAT IQH

1

can't be found for this document.

Cancel

Figure 5-1

The Finder is unable to find the appropriate disk

You'll also see this message if the application has been moved or
renamed,
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Check to make sure that you have inserted the disk thai contains the

application. If the application is on a 5,25-inch disk, make sure thai

the disk drive door is closed and that you have opened the 5 .25-

inch disk drive icon so that trie 5.25-inch disk icon is on the desk-

top. Then click Try Again. If you realize that you don't have the

application on a disk, click Cancel.

If the Finder is unable to associate the document you tried to open

with the application used lo create it, you'll see the message shown

in Figure 5-2,

m An application can't be found foi this document

n.k

Figure 5-2

The Finder can't associate this document with an application

Click OK. Then open the application used to create the docurrM i

and open the document from the application. The next lime you try

lo open the document, you should Ixn successful. If you're not,

continue to start ihc application by opening ihc application icon

rather than the document icon.
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This chapter has two
|

"Menu Commands" includes a brief description of each Finder

command, organized by menu

a "Menu Shortcuts" lists the keystrokes used lo activate menu

commands from the keyboard.

Menu commands
Titles of menus appear in the menu bar across the lop of the screen.

Pressing the mouse button when the pointer is on a menu title

displays the menu. Menu commands that are displayed in black

type can be used right now, those that are dimmed cannot be used

right now. If you choose a dimmed command, you'll see a dialog

box explaining how to activate the command. If you don't want the

Finder to display this dialog box when you choose a dimmed menu

command, choose Preferences from the Special menu and turn off

the "Display help for dimmed menu commands" option.

A d9sk accessory Is a "mlnl-

applScation" that Is available

from the Apple menu regard-
less of which application you
are using.

The Apple menu
The commands in the Apple menu provide general information

about die Finder. The Apple menu also lists desk accessories that

have been installed on your system.

About the Finder

Names the authors and gives the version number of the Finder.

Rbout the finder.

Help

Figure 6-1

The Apple menu

Help

Displays a dialog box listing Finder operations about which you

can get information. Click [lie button next to the operation you're

interested in; then click OK. The Finder displays a window with

information about that operation.
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Open :0

Print

NwFoldei gH

Get Info ol

Duplicate oD

Put Back

Rename

Quit cq

Figure 6-2

The File menu

The File menu
The commands in the File menu help you to manipulate files,

folders, disks, icons, and windows

Open

Opens any selected icon.

If the selected icon represents a 5.25-inch disk drive, choosing

Open displays another icon representing the disk in that drive.

If the selected icon represents a disk or folder, choosing Open
displays a director}' window dial lists the contents of the disk or

folder.

If the selected icon represents an application, choosing Open starts

the application. If the icon represents a document, choosing Open
may start the application that was used to create the document. If

the Finder is unable to associate an application with the document
you tried to open, a dialog box appears. See Chapter 5, "Starting

Applications," for more information.

Print

Tries to print the documents represented by the selected icons. If

the selected icons were created using different applications, the

Finder will continue to print until it comes across a document
created with an application different from that of the first document
printed,

Refer to the user's manual for each application for more informa-

tion on how to print with that application, liefer to your printer

manual for information about using your printer

Close

Closes the active window The next frontmost window, if there is

one, becomes the active window
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For advanced users: When you close a window, the Finder

places a FINDER,DATA file in the directory of the window being

dosed. This file "remembers" (lie position and size of the win-

dow on the desktop and ihe position and color of the icons in

ihe window. The next time you open the window, it will be in the

same position on the desktop and the icons will be the same

< I: if and in ihe same position in the window.

You can minimize the lime it takes the Finder to close a window

by changing the default option so that the Finder doesn't create

the F1NDER.DATA file when you close a window. Choose Pref-

erences from lite Special menu and turn off the "Save Finder

Information onto disk" option.

If you hold down the Option key while you close a window, the

Finder does the opposite of what i.s specified in the Preferences

menu. For example-, if the "Save Finder information onto disk

option is turned on and you hold down the Option key while

closing a window, the Finder wont save the Finder information

onto disk.

Close All

Closes all windows.

•! For advanced users When you close alt windows, the Finder

places a FINDER.DATA file in the directory of each window
being closed These files "remember" the size and position of

each window on the desktop and the position and color of the

icons in each window Ihe next time you open a window, it will

be in the same position on the desktop and the icons will be the

same color and in the same position in the window.

You can minimize the lime il lakes the Finder to close all

windows by changing the default option so that the Finder

doesn't create F1NDER.DATA files when you choose Close All.

Choose Preferences from the Special menu and turn off the

"Save Finder information onto disk
1
' option,
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If you hold down ihc Option key while you choose Close All, the

Finder does the opposite of what is specified in the Preferences

menu. For, example, if the "Save Finder information onto disk''

option is turned on and you hold down the Option key while you
choose Close All, the Finder won't save the Finder information

onto disk.

New Folder

Places an empty folder in the active window.

The folder will be named UNTITLED unless that name is already

used in the directory. In that case, ; r will be named
UNTITLFD.A. This process continues until the Finder reaches

nTLED.Z, If all possible names through UNTITLED./, arc taken,

the Finder cannot create any more new folders in thai directory.

Get Info

Displays a window that contains information about the selected

io m

For Tile, folder, and disk icons, the information includes

the kind of icon selected

the size ol the item the icon represents

If the icon represents a file or folder, the information also includes

n the name of the disk containing that file or folder

I the date the item was created

the date the item was last modified

whether the item is locked or unlocked

See "Locking and Unlocking Files and Folders" in Chapter 4 for

more information.

You also can gel information about the Trash icon and 5.25-inch

disk drive icons.
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Duplicate

Duplicates the selected file or folder and places it in the same folder

or disk directory as the original. See "Copying Items Into the Same
Folder or Disk Directory" in Chapter 4 for more information.

Put Back

Puts all selected files and folders on the desktop or in the Trash
window back in the folder or disk directory window from which they
were most recently moved.

Rename

Lets you rename the selected icon, When you choose Rename, a
box appears around the name of the selected icon. Type a new
name or edit the existing name; then press Return. For more
information, sec "Renaming Icons" in Chapter 2.

QuH

Quits the Finder.

For advanced users: When you choose Quit, the Finder places
a FINDER.ROOT file in the directory of each disk. These files

tell the Finder which windows to display the next time the disk
icons are placed on the desktop. The Finder also creates a
FINDER.DATA file for each window on the desktop thai tells the
Finder the size and position of the window and the color and

ion of the icons in the window.

If you want the Finder to shut down more quickly, you can
change the default option so that the Finder doesn't create
I [XDF.R.ROOT and FINDER.DATA files when you choose Quit.
Choose Preferences from the Special menu and turn off the
"Save Finder information onto disk" option.

If you hold down the Option key while you choose Quit, the
Finder does the opposite of what is specified in the Preferences
menu. For example, if the "Save Finder information onto disk"
option is turned on and you hold down the Option key while
choosing Quit, the Finder won't save the Finder information
onto disk.
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Figure 6-3

The Edit menu

The Edit menu
The only command in the Edit menu that can be used with the

Finder is Show Clipboard. This command displays the information

on the clipboard, a temporary storage area Tor information thai has

been cut or copied using an application, Other commands in the

Edit menu can be used for text editing with some desk accessories

available for the Apple TIGS.

.-by Icon

by Snail Icon

by Home

by Date

by Size

by Kind

Figure 6-4

The View menu

The View menu
Commands in the View menu lei you change the way information in

the active directory window is displayed. The ways in which you can

view directories are divided into two categories: by icon and by
text

In the two possible icon views—By Icon and By Small Icon—icons

are initially arranged in rows and columns. If you alter this format,

you can return the icons to a row and column arrangement by

choosing Cleanup from the Special menu.

In any of the four possible text views—By Name, By Date, By Size,

and By Kind—information is arranged in columns.

To select an icon displayed in any of the views, click the- icon or the

icon's name.

The current view used to display the directory of the active window is

marked in the View menu by a check mark.

By Icon

Displays the content of the active directory window as full-sized

icons, with the icon name below the icon. You can change the

position of the icons by dragging them.
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By Small Icon

Displays the content ofihc active directory window as small icons,

with the icon name to the right of the icon. You can change the

position or the icons by dragging them. Viewing by small icon is

useful when you have several items in a directory and want to be able

to see all of their icons at once.

By Name

Lists the content of the active directory window alphabetically by

name.

By Date

Lists the content of the active directory window chronologically by

dale of lasi modification. The document most recently changed is

listed first. For folders, the modification dale indicates when you

created a folder or changed its content by adding or removing

items.

By Size

Lists the content of the active directory' window by size, largest first

This view is useful for seeing which files are taking up the most room

on a disk. Each folder is listed according to the size of die folder

itself, which is always 0.5K.

By Kind

Lists the content of the active directory window by type of item. If

the window contains a file, this view lists what kind of file it is—

a

BASIC application, a ProDOS application, and so on.
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The Special menu
Commands in the Special menu are used to manipulate disks and

icons and to set preferences.

Cleanup

Select All

Remove-.

Empty Trash

IH

Eject

Erase Disk

Initialize Bisk..

Preferences...

Figure 6-5

The Special menu

Cleanup

Arranges all icons in the active window in neat rows and columns. If

no directory windows arc displayed, Cleanup aligns icons on the

desktop.

This option can be used only when you're viewing the content of a

directory by icon or by small icon

Select All

Selects all icons in the active window or, if no windows are

displayed, all icons on the desktop.

Remove

Permanently deletes all selected files and folders if you click OK
when the Remove dialog box appears. IF you don't want the dialog

box to appear when you choose the Remove command, choose the

Preferences command from the Special menu and turn off the

"Double-check before removing files and folders
1

' option

Empty Trash

Permanently deletes the files and folders in the I i ish and frees up
the spac a disk.

Eject

Ejects the 5,5-inch disk represented by the selected icon. If no

3.5-inch disk icons are selected, the Finder ejects any 3.5-inch

disks in your disk drives Ejecting a disk does not remove its icon

or its directory window from the desktop. Sec "ejecting Disks" in

Chapter 3 for more information.

>v The Eject command has no effeci on 5.25-inch disks.
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Erase Disk

Erases all information on [he disk represented by the selected icon.

See "Erasing Disks" in Chapter 3 for more information.

Initialize Disk

Initializes the disk represented by the selected icon as a ProDOS
disk. When you initialize a disk, ail information on the disk is

i J. See "Initializing Disks" in Chapter 3 for more information.

Preferences

The Preferences dialog box lets you control several Finder options.

When an option is aimed on, an X appears in the check box next to

the option name. When an option is turned off, the check box is

blank. Click the check box to add or remove the XL

Following is a list of the options that appear in the Preferences

dialog box, Each of these opt& ins is turned on when the Finder is

started for the first time. When you make changes in the Preferences

dialog box, the changes go into effect immediately. Preferences are

saved on the system disk in a file called FINDER.DEF when you quit

the Finder or start an application.

Display help for dimmed menu commands: When you choose a

dimmed menu command, a dialog box appears explaining how to

activate the command. If you don't want this dialog box to appear,

turn off this option.

Double-check before removing files and folders: When you
choose Remove from the Special menu, a dialog box appears asking

you to confirm that you want to remove the selected items. If you
don't want this dialog box to appear, turn off this option.

Color selected Icon's background instead of its outline: When
you select an icon and then choose a color from the Color menu,
the Finder colors the background or the selected icon. To color the

icon's outline instead of its background, turn off this option. See
"The Color Menu" below for more information.
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Save Finder information onto disk; When you close a window or

choose Quit, the Finder creates a FINDKR.DATA file on the disk that

"remembers" the window's size and position on the desktop and the

color and position of icons in the window. When you eject a disk by
dragging it into the Trash, or when you quit the Finder, the Finder

creates a F1NDLR.ROOT file on the disk that "remembers" which
windows were open when the disk was ejected. If you don't want the

Finder in create these files, turn off this option.

Hid© the Finder's data files: When you display the directory of a

window or of a disk, die Finder does not list the FINDER.DATA and
F1NDHR.ROOT files. If you want these files to be displayed in the

directory, turn off this option,

Do a smart block copy when copying disks of the same size:

When copying disks of the same size, the Finder copies disks a block

at a lime but normally copies only those blocks thai contain infor-

mation. This is called a smart block copy because die Finder is

ig only Lhosc blocks thai are useful. If you want the finder to

copy all blocks regardless of whether they contain information, turn

off this option. If you copy disks of the same size and then find you
are unable lo use the copy you created, you may want to turn this

option off and try making another copy.

The Color menu
This menu lets you change the color of icons.

Select the icons you want lo color, then choose a color from the

Color menu. An option in the Preferences dialog box determines
whether the outline or background of icons is colored. (See Figure

6-6.)
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Background

Outline

« File Edit

SVSJThOISK

£

Figure 6-6

A colored icon

The Finder's default option is lo color the background of the

selected icon. If you want to color the outline, choose Preferences

from the Special menu and remove the X in the check box next to

"Color selected icon's background instead of its outline." See

"Preferences" earlier in this chapter for more information.

If you hold down the Option key while you choose a color from

the Color menu, the color you have chosen will be applied to

the opposite portion of the icon than is normally the case. For

example, if "Color selected icon's background instead of its

outline" is checked in Lhe Preferences dialog box and you hold

down the Option key while you choose a color from the Color

menu, the icon's outline will be colored.

The colors of the icons in a window are saved in a FINDER.DATA
file when you close the window, drag the disk icon into the Trash,

or quit the Finder. Sec "Close" in "The File Menu" earlier in this

chapter for more information about the FINDER.DATA file.
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Important The Color option works best when used to color black-and-
white icons. It you color a gray icon, such as a 5.25-inch disk

drive icon, or an Icon that starts out colored, such as the
RAM disk icon, the color that Is applied to the Icon will not
necessarily be the color you choose from the Color menu,

Menu shortcuts

In some instances, you may prefer to use the keyboard to give a

command instead of using ihe mouse to choose a command from a
menu. Table 6-1 lists the keystrokes that can be used to give certain

menu commands.

Table 6-1

Menu shortcuts

To choose Press

Duplicate (3-D

Eject (5-E

Empty Trash c5-T

Gel Info C-I

New Folder (3-[\T

Open ri_o

Quit c5_q

Remove c5-R

Select All <3_a
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This chapter lists, in alphabetical order, several of ihe messages

vou may sec while using the Finder. Each listing explains why the

dialog box appears and how to respond to it. This list doesn't

include many messages that arc described in other parts of this

guide, nor does it include messages that arc self-explanatory, such

as "Are you sure you want to cancel this operation?"

An application can'l be found lor this document.

You tried to start up an application by opening a document that was

created using that application.

The Finder is unable to associate the document you tried to open

with the application used to create the document Click OK. Then

open the application by double-clicking its icon.

Completely replace the contents of "DESTINAT.DISK" with Ihe

contents ol "SOURCE.DISK"?

When copying the content of the source disk to the destination disk,

the Finder will erase everything on the destination disk and replace

it with everything on the source disk. If that's what you intended,

click OK. Otherwise click Cancel.

Disk icons can't be dragged with file or folder Icons for this

operation.

When dragging icons Into the Trash or when dragging icons to copy

them, you tried to drag a disk icon and a file or folder icon at the

same' time. To perform these operations, you can drag either disk

icons or (lie and folder icons, but not both simultaneously.

Disks can be dragged only onlo other disks.

You tried to drag a disk icon onto some other type of icon or into

some other type of window. Disk icons can be dragged only onlo

other disk icons, into disk windows, or into the Trash.

To copy a disk, drag the source disk icon onto the destination disk

icon or inio the destination disk window.
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Filenames must begin with a letter.

When naming a duplicate, file, von began ihe name with a character

other than a letter

Delete the first character or type a new name.

5,25-inch disk drive icons can't be moved info a window or
onto another icon.

You tried to drag a 5.25-inch disk drive icon into a window or onto
another icon. In order to drag the disk icon that's inside the disk

drive icon, you must open the drive icon by double-clicking it, or

by selecting it and choosing Open from the File menu.

Initializolion failed.

Your disk is probably damaged. Click OK. Then in.se rt another disk
and try again. If you want to find out whether the disk is damaged,
use the Verify a Disk command in the System Utilities. For more
information see "Verifying That a Disk Is Kcadable" m Chapter 1

1

Initialization failed. This disk is write protected.

You tried to initialize a write-protected disk. If appropriate, remove
the disk and remove the write protection-, then insert the disk and
click Try Again, Otherwise click Cancel.

When a disk is write protected, you can't make any changes to it. If a

3.5-inch disk is write protected, you can remove the write protec-
tion by sliding the write-protect tab to cover the square opening in

the corner of the disk. If a 5 25-inch disk is write protected, you can
remove the write protection by removing the disk's adhesive write-

protect label from the notch on the side of the disk.

If the manufacturer write protected a disk, [here was probably a

good reason for it; you should consider initializing a different disk.
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Items in the Trash can't be opened. Please drag the items back
Into a disk or folder window.

You tried to open a file or folder that's in the Trash window. Before

you can open a file or folder, it must be in a folder or disk window

Items on the desktop and in the Trash can't be duplicated.

Please drag the items back Into a disk or folder window.

You tried lo duplicate files or folders in ihe Trash or on the desktop.

Before duplicating these items, you must move them back into a

disk or folder window.

Memory is full. Can't complete this operation.

There is no more available memory in the Apple 1IGS. Click Cancel.

Then close some windows and try the operation again. If you get the

same message again, restart the computer.

System Error! Can't complete this operation.

The Finder encountered an error that prohibits it from completing

this operation. Click Cancel, then try the operation again. If you

still get the System Error message, restart the Finder. If you continue

lo gel the same error, report it to your authorized Apple dealer.

If you received this message while trying to move or copy Items

onto a RAM disk or duplicate items on a RAM disk, it may be

because the minimum and maximum RAM disk sizes are not set ic

>

[tie same value. To solve the problem, use the Control Panel to

change the minimum and maximum settings for RAM disk size

Then restart your computer and try the operation again. For

information on using the Control Panel to set the RAM disk size,

refer to the Apple TIGS Owner's Guide

That name is already taken. Please use a different name.

Ihe Finder doesn't permit two icons in the same folder or disk

directory to have [he same name. Assign the icon a different name.
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The application "APPNAME" can't bo found for this document.

The Finder is unable to locate the application used to create the

document you're trying to open. Check to make sure that you have
inserted the disk that contains the application. If the application is

on a 5.25-inch disk, make sure the disk drive door is closed- Then
click Try Again, If you know you don't have the application on a

disk, or if you have moved or renamed the application, click

Cancel.

The disk directory Is full. Can't complete this operation.

You already have a total of 51 files and folders in the disk directory,

the maximum number that ProDOS allows. Move some files into

folders, delete extraneous files, or copy some files and folders onto
another disk and then remove them from this disk.

The disk "DISKNAME" Is write protected.

You arc trying to perform an operation on a disk that is write

protected. If appropriate, remove the disk, remove the wriie

protection, insert the disk, and click Try Again. Otherwise click

Cancel,

When a disk is write protected, you can't make any changes to it. If a

3-5-inch disk is write protected, you cart remove the write protec-

tion by sliding the write-protect tab to cover the square opening in

the corner of the disk. If a 5.25-inch disk is write protected, you can
remove the write protection by removing the disk's adhesive write-

protect label from the notch on the side of the disk

The disk Is full. Can't complete this operation.

You have run out of room on this disk. View the directory by icon

to see how much space is available. Then view the directory by
name to see how much room each file on the disk occupies. Use the

Remove command to delete files you no longer need, or copy some
files to another disk and then remove ihcm from the full disk. Note
that folders are always listed as having a size of 0.5K, no mailer how
many items they contain.
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The file/folder "FILENAME" already exists and is locked (or

contains items that are locked). Replace II anyway?

You tried to move or copy an item thai has the same name as one
of the following items in ihc destination folder or destination disk

directory: a locked file, a locked folder, or an unlocked folder

that contains a locked item. If you want to replace Lhe item in the

destination folder or disk, click Yes. If you don't want to replace

the item but warn the Finder to continue the moving or copying
procedure, click No. If you want to stop the operation, click Cancel.

The file/folder "FILENAME" can't replace the folder that

contains it.

You have nested a file or folder inside another folder and have
given both items the same name. Then you tried to move the nested

item into the directory window containing the outer folder.

For example, suppose you created a folder called MEMBERSHIP
and placed a folder also called MEMBERSHIP inside the first

folder. Then you tried to move the nested MEMBERSHIP folder

into the window that contains the outer MEMBERSHIP folder.

If you're moving or copying several items, click Skip File to go on to

the next item. Otherwise click Cancel.

The file/folder "FILENAME" is copy protected and cani be
copied.

You have tried to copy or duplicate a file that is copy protected.

When a file is copy protected, it cannot be copied If you're

copying or duplicating several files, click Skip File to go on to the

next file. Otherwise click Cancel.

The file/folder "FILENAME" is locked (or contains items that are
locked). Remove it anyway?

You have tried to remove or throw away a file or a folder that is

locked or a folder that contains locked items. If that's what you
intended, click Yes. If you don't want to remove the item but want
to continue removing other selected items, click No. If you want
to slop the operation, click Cancel.
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The filename "ANYNAME" is already used.

You have chosen a name for a duplicate Hie or folder that has

already been used for an item in die destination folder or disk

directory. To choose another name, simply specify the new name
and click OK. To skip this item and duplicate the next item you

selected, click Skip File. To cancel the duplicating operation, click

Cancel.

The folder "FOIDERNAME™ can't be moved Into Itself or Into

one of its own folders.

You have nested a folder inside another folder and ihen attempted

to copy the outer folder into the nested folder.

For example, you created a folder called YEARLY, BILLS and placed

a folder called JANUARY. RILLS inside that folder. Then you tried to

drag the YEARLY.BILLS folder icon on top of the JANUARY.BILLS
folder icon or into the JANUARY.BELLS window. Or you tried to

drag the YEARLY.BILLS folder icon into the YEARLY.BILLS
window.

If you're moving or copying several items, click Skip File to go on to

ihe next item. Otherwise click Cancel.

The folder "FOLDERNAME" is copy protected and can't be
accessed. Can't complete this operation.

You have tried to copy or duplicate a folder that is copy protected.

When a folder is copy protected, it cannot be copied.

The name you typed is not valid. The first character In the
name must be a letter.

When naming a file, folder, or disk, you began the name with a

character other than a letter.

Delete the first character or type a new name.
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The pathname DISKNAME/FOLDERNAME/RLENAME contains
more lhan 64 characters. Can't complete this operation.

When dragging a file or folder into another folder or onto another
disk, you created a pathname that exceeds 64 characters.

Suppose, for example, that you have a disk called IIOU5E.PROJ-
ECTS. On thai disk you have a folder called FLOOR,COVERINGS
that's inside a folder called QVTNGRQOM On another disk you
have a folder called PRICE-LIST that's inside a folder called MAN-
UFACTURERS. If you try lo copy the MANUFACTURERS folder

inside the FLOOR.COVERINGS folder, ihe pathname will be

HOUSH.PROJECTS/LIVINGROOM/FLOOR.COVERINGS/MANli-
FACTURERS/PRICELIST, which has 66 characters—two over the

maximum.

To avoid this message, shorten one of the names in the pathname
or reduce the number of levels of folders,

The pathname is too long to complete the operation.

The Finder cannot open a folder whose pathname has more than 48
characters. Shorten one of the names in the pathname or use fewer
levels of folders.

The Trash icon can't be moved Info a window or onto another
icon.

You tried lo drag the Trash icon on top of another icon or into a

window. If you want to move an icon that's in the Trash into a folder

or onto a disk, open the Trash icon and drag the icon you want to

move out of the Trash window and on lop of the icon or into the

window where it belongs.

The two disks are different sizes so the contents of "SOURCE.
DISK" will be placed in a folder on "DESTI NAT. DISK."

When copying the content of the source disk to the destination disk,

the Finder will copy everything on the source disk into a folder on
the destination disk. If that's what you intended, click OK.
Otherwise click Cancel.
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There Isn't enough room on "DE5TINAT.DISK" lo copy »h©
contents of "SOURCE.DfSK."

There isn't enough room on the destination disk to copy everything
on the source disk. You can try copying the disk again using a
different destination disk, or you can drag only selected files and
folders onto the destination disk,

These items are from different disks. Please move them
separately.

You selected files and folders that are not stored on the same disk
and then tried to drag them. Deselect all icons. Then select only
icons stored on the same disk.

This disk Is unreadable. Do you want to initialize it as a ProDOS
disk?

You have inserted a blank disk that has never been initialized To
initialize the disk as a ProDOS disk, click Initialize. Otherwise click
Eject. If you decide not to initialize a 5.25-inch disk, open the drive
door and remove the disk after you have clicked Eject.

This disk was Initialized for another operaling system and can I

be read by ProDOS. Do you want to initialize It as a ProDOS
disk?

The disk you have inserted was initialised for the DOS 3.3, Pascal,
or Macintosh operating system.

If you want to erase everything on the disk and initialize it as a
ProDOS disk, click Initialize. If you don't want to erase everything
on trie disk or if you want to initialize the disk so it can be used with
an operating system other than ProDOS, click Eject. IT you decide
not to initialize a 5.25-inch disk, open the drive door and remove
the disk after you have clicked Eject,

You are attempting to repface a file with a folder or vice versa
Should if be replaced?

When copying or moving items, you have instructed the Finder to
oe an item on the destination disk with an item on the .source

lis* that ha.s the same name. But one of [he items i.s a Hie and the
other is a folder.
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If you wani to replace the kern on ihc destination disk, click Yes.

If you want to leave (he original item on the destination disk and

continue the copying procedure, click No. If you want to discon-

tinue the copying operation, click Cancel.
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Part 2

The System Utilities

How to use this guide ro learn the System Utilities

If you've never used the

system disk before*,.

If you're new to compu his

If you wanl an overview of

how the System Utilities work.

Ifyou want to know how to

accomplish a specific task...

If you have a problem...

read Chapter 8, which explains

how to get started and how to

make a working copy of the

system disk.

read Chapter 9, a hands-on

introduction to the System

Utilities-

read Cha pier 10,

refer to the step-by step

instructions in Chapters

11 through 13-

turn to Chapter 14.
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This part of the Apple 1IGS System Disk User's Guide explains how

to use the Program Launcher, System Utilities, and FastCopy.

The Program Launcher is a mouse-based application that shows

you what's on a disk and allows you to start applications very

easily. It's trie first thing you see when you start up the system disk

with a 256K system. (If you have a memory expansion card, you

will see the Finder desktop instead of the Program Launcher. For

instructions on using the Finder, turn to Part 1 of this guide.)

n System Utilities is a program that lets you accomplish a variety of

disk housekeeping chores like copying disks, checking to see what

files are on a disk, copying files, deleting files, renaming files

—

the same kinds of things you can do with the Finder Unlike trie

Finder, which works only with ProDOS disks and files, you can

use the System Utilities with disks that use any of the Apple II

operating systems: ProDOS, DOS 33, and Pascal. Also unlike

the Hinder, the System Utilities do not recognize mouse moves.

You control the utilities using keyboard commands.

a FastCopy is a special utility for copying disks. You'll use it later in

this chapter to make a copy of the system disk.

Starting up
Put the system disk in your startup drive and turn on the power.

After a few seconds, you see a screen similar lo the one shown in

Figure 8-1
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Click her© to see the contents
of another disk

Click here to open the selected
application or folder

Dimmed file (can't be opened)

Application

Click here to close the sub-
directory you're looking at

Subdirectory

Click here to leave the
Program Launcher

El /SVSTEH.DISK/

«PPL€IflLK

^BftSIC.SVSTEH

D COPV.NE

LD ICOHS

QStS.UIILS

Version 2.0

Figure 8-1

The Program Launcher

This is the Program Launcher. It shows you what's on your disk and
allows you to start applications easily.

The Program Launcher
This section explains how the Program Launcher works. After this

overview, you'll learn how to use the Program Launcher to launch

ihe PastCopy application on the system disk.

The following discussion assumes thai you know how to use ihe

mouse. If you do nol, read aboui using ihe mouse in the Apple Has
Owner's Guide and practice using the mouse with Your Tour ofthe
Apple 11GS, the training disk that came with your computer
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Starting an application

To start an application using the Program Launcher, select the

application you want and dick Open. (You can also open an

application by clicking twice—known as double-clicking—on the

name.) If you don't see the application you want to open, click the

arrows in the scroll bar until the name of the file you want comes

into view.

It" you don't have a mouse, or if you prefer controlling the program

with keyboard commands, select the file you want to work on by

typing the first letter of the file name. If more than one file starts

with that letter, press the Down Arrow key until the correct file is

highlighted. When the correct Pile is highlighted, press Return to

open it. To see other files on the disk, you can press the Up Arrow

key or the Down Arrow key iastead of clicking the arrows on the

scroll bar.

Opening a subdirectory

A subdirectory Es like a file folder containing related files. It allows

you in store documents together on a disk. If the application you

want to open is in a subdirectory, select the subdirectory name and

click Open, (You can also open a subdirectory by double-clicking

the name, or by pressing Down Arrow until the name is highlighted

and then pressing Return.) When you open a subdirectory, you see

a list of what's in it-, you can then open one of tile subdirectori

applications in that subdirectory by selecting its name and clicking

Open, To dose a subdirectory, click the Close button; you'll return

to the previous directory. You can also close a subdirectory by

pressing the Esc (Escape) ke>

.

If a name or command is dimmed, ii means you can't use it. For

example, document names are dimmed because you cannot npen

documents from the Program Launcher. You must open documents

from within the application you used to create them.
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Opening another disk

If ihe application you want 10 open is on another disk, click the Disk

button. When you click the Disk button, the Program Launcher first

checks the current drive to see whether you've inserted a differeni

disk. If you haven't, it goes on to the next disk drive connected to

your computer and displays the contents of the disk it finds there.

You can also tell the Program Launcher to display the contents or a

different disk by pressing Tab.

Getting in and out of the Program Launcher

When you quit a PmDOS-based application, you return to the

Program launcher. When you quit a Pascal- or DOS 3.3-based
application, you don't. To gel to the Program Launcher after using a

Pascal- or DOS 3-3-based application, you must restart the system
disk.

To leave the Program Launcher without opening an application

click the Quit button and fallow the instructions on die screen.

When you have chosen Quit, press Up Arrow or Down Arrow—not

the mouse—to select what you want to do next, and then press

Return,

You can also quit by holding down the Apple key while you press the

period key.

Using FastCopy

Before you go any further, its a good idea to make a working copy of
your Apple IICS System Disk. Once you've copied the disk, put the

original in a safe place so thai you'll be able to copy it again if some-
thing should happen to your working copy.
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1

.

Open the folder called SYS.UTILS,

2. Open the application called FASTCOPY.SYSTEM.

3 . After a few seconds, you see the FastCopy tide screen and then

the FastCopy menu (see Figure 8-2),

RAM disk users. Before the FastCopy menu appears, you will

be asked whether it's OK for FastCopy to erase the contents of

your RAM disk. If you don't mind losing what's stored on your

RAM disk, press Right Arrow to highlight Yes, then press

Return. If you don't want to lose the information on your RAM

disk, press Return; FastCopy will use only the unused portion

of your RAM disk.

Figure 8-2

The FastCopy menu
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Highlighted number Indicates the
type of disk you will copy

Copying disks

1

.

Press Return lo sclecl Copy Disks.

Need help?'Instructions in the lower-left corner of the screen tell

you what to do next. Fbr additional information, press Apple-?

(When you arc asked in this manual to press two or more keys

whose names are joined by hyphens, you should press the keys

simultaneously and then release them.)

2, If asked, select the type of drive you want to use for the copy, (See

Figure 8-3.) Highlight the option you want by pressing the Left

Arrow key or the Right Arrow key, then press Return.

Please sell

;-• a '

II]

vm/msR

Figure 6-3

The Copy Disks screen

n Tf you select 3-5, the program ejects any 3-5-inch disks in the

3.5-inch disk drives connected to your system so that you can

insert the disks you want to copy from and to.
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To write protect a 3 5-inch

disk, slide the tab to uncover
the square opening In the

corner of the disk, To write

protect o 5.25-Inch disk,

cover the notch on the side

of the disk with one of the

adhesive wnite-protect labels

that come with the disk, or

us© ordinary masking tape.

If you select 5.25, you are asked whether you have one or two

5.25-inch drives. Highlight the option you want by pressing

left Arrow or Right Arrow, then press Return. (Once you've

answered this question, the program remembers your re-

sponse and doesn't ask again until you restart the system disk,)

3 . A message appears at the bottom of the screen asking you to

insert your source disk—the disk you want to copy. Write

protect the system disk and insert it in any of your 3.5-inch disk

drives. (With 5.25-inch disks, you must put the source disk in

your startup drive and press Return.)

4 . If you are using two drives, a message at the bottom of the screen

tells you to insert your destination disk. Insert a blank disk, or a

disk you don't mind erasing, and press Return.

5. If the disk is blank, you see a message asking whether you want lo

format the disk, Press Right Arrow to highlight Yes
r
then press

Return. If the disk has information on it, you are asked whether

it's OK to destroy that data.

6. If you are using one drive, swap the source disk for the destination

disk when prompted by messages on the screen.

I* Ilow it works: FastCopy reads as much information from the

source disk as it can fit in memory. As it is reading information

from the disk, you see a message indicating what percentage of

the source disk has been read. (If you have a memory expan-

sion card installed in your computer, the program is able to

read a tot more information at one time than if you don't.)

When FastCopy has read as much information as your com-

puter's memory can handle, it writes the information to the

destination disk. As the program is writing information to the

destination disk, you see a message indicating what percentage

of the information has been written to the destination dusk. If

you have two drives of the same type, the reading and writing

proceed without any intervention on your part. If you have

only one drive, you may need to swap the source disk for the

destination disk several times

7 . When FastCopy has finished writing all information to the

destination disk, you see the message "Copy complete." Press

i to go back lo the FastCopy menu.
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Multiple copies. Depending on the amount of dala on the source
disk and the amount of memory available in your system, all the
data to be copied may fit in memory ai once. In this case, after

making one copy, the program gives you the option of making
additional copies without rereading the source, This option is

convenient if you need to make several copies of the same disk-

Its especially convenient with a one-drive system because it

allows you to make additional copies without reinserting the
source disk.

Comparing disks

Comparing disks is a good way to verify that a backup disk matches
the source. Use the Compare Disks option now to check your copy
of the system disk against the source.

1 From the FastCopy menu, press Up Arrow or Down Arrow to
highlighi Compare Disks, then press Return.

2. Select the drive type.

3
.

If asked, select the number of drives. Press Left Arrow or Right
Arrow to highlight the option you want.

4. Write protect and insert the original system disk, then press
Return.

You see a message indicating what percentage of the source disk
has been read.

5. Insert the copy of the system disk when the message at the bottom
of the screen lelts you to insert the destination disk. Then press
Return.

You see a message indicating what percentage of the destination
disk has been compared.

6 If you're using a one-drive system, swap the source disk for the
destination disk when prompted by messages on the screen.

7. When the disk comparison is complete, you see the message
"Disks match" or "Disks don't match," If your disks match, put
the original system disk in a safe place and use the copy as your
working system disk. If the disks don't match, try copying the disk
again.
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8. Press Return to go back to the I'astCopy menu,

9. Press Up Arrow or Down Arrow to highlight Quit, Then press

Return. Confirm that you want to quit by pressing Right Arrow.

Then press Return again. After a few seconds, you should find

yourself back at the Program Launcher.

File Is a generic term for a
document, a program, or a
subdirectory— anything that
you save by name on a disk.

About System Utilities

The rest of Part 2 explains how to use the System Utilities on your

system disk. Before you turn to Chapter 9 Tor a hands-on

introduction to the utilities or put the book aside to master the

utilities on your own, you need to know how to specify the location

of the disk or file you want to copy, delete, rename, or otherwise

manipulate.

There arc two ways to specify the location of a disk or file: by slot

and drive number or by ProDOS pathname.

«$* In general: Use the slol-and-drive method when you know the

location of a disk but don't know its name. Use the ProDOS path-

name method if you need to work with files in subdirectories, or if

you know the disk name but don.1 know which drive the disk is in.

Slot and drive

If your disk drive is connected through a card in a slot, you won't
have any difficulty providing the slot number Tf your drive is con-
nected to the disk drive pom, you need to know which slot number
corresponds to the disk drive port. (Ports are designed to imitate

slots so that applications designed for models of the Apple II with

slots will run on models of the Apple II with ports.) See Table 8-1 for

the slot equivalents of your disk drives.
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if you have more lhan one drive connected to a card, the drive

connected directly to the card is drive 1; the drive connected to

drive 1 is drive 2. If your drives are connected to the disk drive port,

the drive connected to the port is drive 1 and the drive connected to

drive 1 is drive 2. If you have both 3-5-inch drives and 5.25-inch

drives daisy-chained to the disk drive port, the 5. 25 -inch drives

should be at the end of the chain. The 525-inch drive nearest the

port is drive 1. The next in line is drive 2.

More than two"slot 5" devices. Only iwo devices can be idenii-

fied with each slot, so if you conned more than two devices to

slot 5, the third and fourth 3.5-inch drives behave as if they are

connected to a card in slot 2. Think of slot 2 as the overflow slot

for "slot 5" devices.

Table 8-1

Apple lies slot equivalents

Disk drive Slot number Drive number

First 3-5
c

> 1

Second 35 5 2

Third 3-5 1 1

Fourth 3.5 I 2

First 5.25 6 1

Second 5.25 6 2

Important A memory expanslon card used as a RAM disk also appears to

be in slot 5. If you have used the Control Panel to designate

your RAM disk as your startup drive, its location Is slot 5, drive 1

If a 3.5-inch drive is designated as your startup drive, the RAM
disk's location Is slot 5, drive 2. In either case, the second 3.5-

inch drive's location Is slot 2, drive 1

.
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ProDOS Pathname

Another way of specifying the localion of a disk or file is by its

pathname. A pathname provides a trail of names leading the

computer first to a disk, then to a subdirectory, if any, on thai disk,

and eventually to a file in that subdirectory. A pathname begins with

a slash, and every part of the pathname Is separated by a slash. For

example, the pathname for a file called PELE in a subdirectory

called SOCCER on a disk called SPORTS would look like this:

S I C )RTS/SOCCER/PELE.

If you don't know about subdirectories already, use the slot-and-

drive method for specifying the localion of disks and files. (You'll

learn how to create subdirectories in Chapter 9) Once you start

using subdirectories, you'll need 10 use the ProDOS pathname to

specify the subdirectory containing the files you want to work on.

Now what?

At this point you can proceed to Chapter 9 for a hands-on intro-

duction to System Utilities, you can explore the utilities on your

own, or you can take a break.

If you decide to explore the utilities on your own and find lhat you

need help, turn to Chapters 11, 12, and 13 for reference. Topics

there arc arranged in their order of appearance on the Main Menu

of the utilities and include step-by-slep directions.
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Chapter 9

An Introduction to Utilities
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As the name implies, the utilities are useful programs. In this

chapter you'll sec how ihey can come in handy, and you'll gel a

step-by-stcp introduction to some of iheir most common uses.

Utilities are programs that
help you work with disks and
documents.

The idea of utilities

As you use your computer, you save a lot of information on disks.

Before you know it, you could have shoe boxes full of disks and no
idea where to find the information you want.

You need some way to organize the information on those disks

—

a way to find out what's on a particular disk, a wray to delete docu-

ments, a way to protect crucial documents from accidental erasure.

You can do all these things and more with the utilities on the

Apple ITCS System Disk

The utilities are a little different from other applications. You don't

use the utilities to create a document, you use them to rearrange

documenis created with other applications.

By the way: In trie utilities, you will see the term volume where

you might expect to sec the word disk. A volume is a storage area

fur data When you're working with 5.25-inch and 3. 5-inch disks,

you have only one volume per disk, so the terms are synony-

mous—the disk name is the volume name. With larger storage

devices there can be many volumes on one disk; that's why the

utilities sometimes make a distinction between disks and
volumes.

What follows is a brief outline of the ways trie utilities can help you
manage disks and documents.

Figure 9-1

Boxes of disks

Working with disks

When you're working with disks, you can use the utilities to

3 show you what documenis and applications are on a particular

disk (known in the utilities as cataloging a disk)

u make a copy of a whole disk {duplicating a disk)

i prepare a disk to store information (formatting a disk)
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make sure that a disk is in good shape (.verifying a disk)

a give a formatted disk a new name without disturbing its contents

(.renaming a voiume)

tell you the names of the disks in your disk drives (listing

volumes)

Working with files

A file is any body of information stored by name on a disk. A
document, for instance, is a file. When preserving and organizing
your files, you can use the utilities to

make a copy of one or more files (copying files)

delete files you no longer need (deletingfiles)

Q give new names to existing files (renaming files)

protect files from accidental changes (locking files)

remove protection, allowing changes to be made to files

(unlocking files')

D create a folder to contain a group of related files and a list of
those files (creating a subdirectory)

u set up a shortcut to a particular disk or subdirectory, for faster

access and less typing (setting a prefix)

Many applications perform similar services, at least when you're
working with the files they helped you create. If the application

you're using has some utilities built in, you won't need to use the

utilities on the system disk very often. If an application does not let

you format a disk, copy a file, or create a subdirectory, though, you
can always turn to the system disk,

A hands-on tutorial

The best way to learn about the utilities is to use them. In this sec-
tion, you'll learn how to format a blank disk to receive information,

create a folder to hold new files, copy a file into the folder, and then
check to make sure the copy arrived.
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For this tutorial, you need

your working copy of the system disk

n a blank disk the same size as your system disk

To do this tutorial, you do not need a second disk drive, though if

you have one, it will occasionally come in handy.

Formatting a disk

Before a disk can receive any files, it must be formatted, or

divided into sections where information can be stored. The process

of formatting erases any information on the disk, so you should al-

ways make sure you are using a brand-new disk or one that contains

nothing of value.

1 . With your working copy of the system disk In the startup

drive, turn on the computer and monitor.

You see a list of the files on the system disk. (See Figure 9-2.)
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D CM
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( )

I Quit )

Figure 9-2

Files on the system disk
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If you don't see tills screen after ten or fifteen seconds, make sure
your working copy of the system disk is in the startup drive, then
press Applc-Conirol-Rcset to start the computer again. (Reset is

the key marked with a triangle.) If that doesn't work, check all

your connections, make sure the monitor is plugged in and
turned on, and try again. If you still don't see the menu, some-
thing may have gone wrong when you were making the copy; try

copying again with a different disk.

2. Open the subdirectory called SYS.UTJLS,

3. Open the application called SYSUTILSYSTEM,

In a few moments, you see a screen similar to Figure 9-3> the
Main Menu of the utilities.
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Figure 9-3

The Main Menu of the utilities

4. Press Down Arrow to highlight the Format a Disk option.

The arrow keys move the highlighting left and right, up and
down.
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A default Is the suggested or

standard response, which the

computer will use if you do
not type something else.

5. Press Return to select Ihe highlighted option,

A message appears asking where the disk is. The Slot and Drive

option is highlighted, indicating that the computer needs you to

identify ihe disk's location by slot and drive.

6. To accept this method, press Return.

You see the standard (most common) slot number and drive

number, shown in Figure 9-4. Crhese are the numbers the com-

puter will use if you don't type anything else; such responses are

sometimes known as defaults.)

:•

- • :
- -

Figure 9-4

The Format a Disk screen

You will be using the startup drive to format the disk. The startup

drive is slot 5, drive 1 for 3.5-inch disks; slot 6, drive 1 for 5,25-

Inch disks.
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An operating system Is a set

of programs on every appli-

cation disk that manages the
flow of Information between
disks, the computer's
memory, and peripheral

devices such as printers or

modems. ProDOS Is short for

Professional Disk Operating
System; It's the most recent
operating system used with
Apple II computers.

7. To accept the default slot and drive, press Return. To
change the slot and drive numbers, press Left Arrow or

Right Arrow to highlight the number; then type the new
number. When the information is correct, press Return.

A message appears asking which operating system to use in

formatting the disk.

You must format disks with the same operating system your

application uses, or you won't be able to save tiles on those

disks. The utilities rely on the ProDOS operating system.

Because you're going to copy one of me files from flic utilities,

you need to use ProDOS to format the disk that the file will be

copied onto.

You'll learn more about choosing the correct operating system

in "Choosing an Operating System" in Chapter 10.

The cursor is the blinking

marker that Indicates where
what you type will appear.

8. To use ProDOS in formatting the disk, press Return.

Now you need lo name ihe disk you're formatting. Once
formatted, the disk is known as a volume; it is like a blank

notebook, ready lo receive data.

9. Press Control-X to delete the suggested name for your new
disk, then type TRYOUT.

That's a logical name because you're trying oul ihe utilities.

If you need to make a correction, press Left Arrow or Right

Arrow to move die cursor under a character. To get rid of the

character lo the left of the cursor, use the Delete key. To insert

characters to the left of the cursor, Just start typing.

TO. When you've typed the name just as you want it, press
Return.

You're asked lo place ihe destination disk in the startup drive.

The destination disk is the one you intend lo formal

11. Remove the working copy of the system disk and replace it

with a blank disk. Then press Return.

To remove a disk, press the button on the front of your disk

drive in the upper-right corner,
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This step prevents you from accidentally reformatting the system

disk. If you leave the system disk in the drive, you sec a message

asking whether you really want to destroy the data on it. Just

highlight No and press Return 10 save your original disk.

The utilities formal your blank disk, and after a few moments you

see the message "Formatting... Done!"

You've prepared this disk to receive and store data.

12. To return to the Main Menu, press Return.

A directory lists the files on a
disk, with Information about
each one.

Finding out what's on a disk

Formatting a disk gives it a name and a directory— an empty list

prepared to record the names of any files you save on the disk. The

directory is sometimes known as a catalog. Cataloging a disk shows

you the name of the disk, the operating system used to formal it,

and the names of any Files stored on it. Now you'll catalog the disk

you just formatted to make sure the formatting went well.

1 . In the Main Menu, highlight Catalog a Disk and press Return.

You see a screen similar to the one shown in Figure 9-5
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Figure 9-5

The Catalog a Disk screen

126 Chapter 9: An Introduction to Utilities



Before you can tell the computer where ihe disk to be cataloged

will be, you must pick the method by which you will identify its

location. You can identify the location physically (by slot and
drive) or you can give the disk's name. For now, it's easiest to use

the slot-and-drive method,

2. To choose the slot-and-drive method, press Return.

You now have a chance 10 change the default entries for slot and
drive- (See Figure 9-6}

-:

Press - - select

Iter prss- .

For Helc Press

UT^e jlu*:

Figure 9-6

Default slot and drive numbers

Your newly formatted 3.5-inch disk is in the startup drive. Make
sure the message contains the correct slot and drive numbers. If

the slot number is incorrect, type the correct number. If the

drive number is incorrect, press Right Arrow to move the

highlighting over to Drive; then type the correct number
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3. When you have entered the slot and drive numbers for the

disk you want cataloged, press Return.

The directory appears for your disk named TRYOUT. (See Figure

9-7.)

Operating system usea to
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the directory, meosured in blocks

of 512 byloi , Fllii - :..:..-. !

it : lonplet* Pr

Figure 9-7
The disk directory

You have a directory—and plenty of room to store files on the

disk. ITie formailing was successful.

4. To return to the Main Menu, press Return.

You're now ready to create a subdirectory on ihis disk and copy a

file into it.
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Creating a subdirectory

At this point, you could slop using the utilities, slarl using an

application to create documents, and save thcni on your formatted

disk. But you may want to consider setting up a subdirectory on

your newly formatted disk.

Right now, with no files on the disk, the directory is easy to read.

And with only a few documents saved on trie disk, you'll be able to

spot the one you need right away. (See Figure 9-8.)

DISK
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But as you do more work, adding more and more files to the disk, it

takes more time to search through the directory for a particular file.

(See Figure 9-9.)

DISK

m • = = > FILES

Figure 9-9
A lot of letters on a disk

To locate files more easily, you may want to keep related files

together in subdirectories, the electronic equivalent of large file

folders. A subdirectory contains a group of individual files and a list

of those files—sort of a minidirectory.

The first step in organizing is deciding on a likely category for a

subdirectory. For example, if your disk were filling up with tetters,

among other documents, you might want to create a subdirectory

called LETTERS and copy all your correspondence into that

subdirectory. Your main directory would look a lot less cluttered.

(See Figure 9-10.)
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Figure 9-10

A disk with a subdirectory for letters

Only when you open thai subdirectory will you sec your letters. (See

Figure 9-11)
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Figure 9-11
Inside the subdirectory called LETTERS

A hands-on tutorial 131



You must create the .subdirectory before you can put any files into it,

Follow these -steps to create a subdirectory on the TRYOUT disk:

1. In the Main Menu, choose Create Subdirectory and press

Return.

if you're starting up again, make sure that the working copy of

the system disk is in your startup drive and that you have your

formatted TRYOUT disk at hand; then turn on the power.

* By the way This option is listed under the heading "Work on

ProDOS Disks Only." That's because you can create subdirec-

tories only on disks formatted with the ProDOS operating

system. Earlier operating systems, such as DOS 33 and

Pascal, were designed for 5.25-inch disks, which can hold

only 143K of data; such disks are too small for subdirectories

to be necessary. ProDOS was dc%'eloped so you can work with

larger disks; for instance, a 3.5-inch disk can hold about 800K

of data—a lot more files. To help you keep track of all these

files, ProDOS lets you create subdirectories.

A message asks how you want lo specify the location of your disk.

2. With the Slot and Drive option highlighted, press Return.

You're choosing lo specify the slot and drive number of the disk

on which you want to create a subdirectory

3. Type the number of the slot and drive that will contain the

TRYOUT disk, then press Return.

If you're using the startup drive, replace the working copy of the

system disk with the TRYOUT disk and specify its slot and drive

number, if you're using a second 3.5-inch drive, make sure the

TRYOUT disk is there, then specify the slot and drive number.

4. Name the new subdirectory LETTERS.

Simply type the name and press Return,

Tn a few seconds, you see the message "Create complete" on the

bottom line of the display. The subdirectory has been created.
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5, To return to the Main Menu, press Return.

6, To see what the directory looks like now, choose Catalog a
Disk and press Return.

7. Press Return to accept the slot-and-drive method of

specifying the location of the TRYOUT disk.

8. Specify Ihe location of the TRYOUT disk and press Return.

For information on location, sec "About System Utilities" in

Chapter 8.

'Hie new subdirectory shows up at the top of the directory. (See

Figure 9-12.)

Hpple .i iusteij utilities

Iters ion . 9 ES£ Hair Menu

Pathnaw TRYOUT
:orma ProDOS

Filwane :,.-

LETTER!

! Files Listed : Blocte Used. 1552 Blocks H^ailatle

.istim Met* Press f'ETUPM to return ts Hun Itanu 1

Figure 9-12
The subdirectory appears in the directory

The subdirectory is now ready to receive files.

9. Press Return to return to the Main Menu.
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A backup copy of a file or
disk is one you keep In a safe
place, to be used if you
happen to lose or ruin your
original,

Copying a file

To neaten up the disk, or to make a backup copy or an important
file, you need to use the utilities to copy a file from one disk to

another. If you want to place the copy in a subdirectory, you can
do so as part of the copying procedure.

In this section of the tutorial, you'll copy the file COPY.ME from
your working copy of the system disk into the subdirectory LETTERS
on your new disk TKYOUT

1 . If you have only one drive, remove TRYOUT and replace if

with the working copy of fhe syslem disk. If you have fwo
drives, make sure the working copy of the system disk is in
the startup drive and the TRYOUT disk Is in the other drive.

The working copy of the system disk is [he source of your files so
it must be the first disk the utilities examine.

2. In the Main Menu, use fhe arrow keys to highlight the Copy
Files option; then press Return.

A message asks which method you want to use to identify the
source disk (the disk that will be the source of your files). For now,
continue to use slot and drive numbers.

3. With the highlighting still on Slot and Drive, press Return.

You arc choosing to identify the source disk by its physical
location. You see this message:

Where is your source disk?
Slot 5 Drive 1
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A pathname provides a troll

of names leading the
computer first to the disk,

then to the subdirectory. If

any, and eventually to the
me.

4, Press Return lo accept the default slot and drive numbers, or

type new numbers and press Return.

A message asks which method you want to use lo identify the

location of the destination disk (the disk onio which you are

going to copy these files). In order to put the files into your

new subdirectory, you need to provide a more specific loca-

tion than the slot and drive. You need to name the disk and the

subdirectory, That's what the ProDOS pathname allows.

5. Move the highlighting to ProDOS Pathname and press

Return.

You see the message shown in Figure 9-13.
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Figure 9-13
Specifying where you want the file to be copied

6. Press Control-X to erase the suggested name; then type
TRYOUT /LETTERS and press Return.

You are providing the names of the disk and subdirectory you

warn to copy the file im

A message asks whether you want lo copy all the files or just some.
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7. To copy some files, press Return.

A lisi of all the files in the main directory on the working copy of

the system disk appears (See Figure 9-H) You will copy only

COPY.ME.
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Specifying which file you want to copy

S. Use the arrow keys to highlight COPY.ME. Press the Space

bar to select It, then press Return.

(If you need to deselect another file, use the arrow keys to high*

light it, then press the Space bar again.)

The utilities immediately start copying the file. If you are using

only one disk drive, you are asked after a few seconds to insert

TRYOUT, your destination disk.

9. Follow any messages prompting you to swap disks.

Tf you are using the startup drive and one other disk drive, you

wont have to swap disks.
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With one disk drive, you'll need to remove the system disk and

replace it with TRYOUT; then press Return.

When the file has been copied, you sec the message shown in

Figure 9-15,
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Figure 9-15
Copying Is complete

10. To return to the Main Menu, press Return.

Now that you've added this file, you may want to sec what the

subdirectory LETTERS looks like.

11. In the Main Menu, highlight Catalog a Disk and press

Return.

12. Highlight ProDOS Pathname and press Return.

Ihe pathname is your entry into the subdirectory, (Slots and

drives take you only to the disk's main directory.)
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13. Type /TRYOUT /LETTERS and press Return.

Thai provides ihc pathname Lo Lhe subdirectory on your disk:

/TRYOUT/LETTERS

Figure 9-l6 shows what lhe subdirectory looks like now.
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Figure 9-16

The subdirectory called LETTERS

14. Press Return to return to lhe Main Menu.

Choose Quit in the Main Menu and turn off your computer.

Congratulations!

You've completed a detailed hands-on introduction lo the utilities.

You should be prepared to undertake almost any operation.

For more information about common procedures used with the

utilities, read Chapter 10, "General Instructions on Using the

Utilities."
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You'll find slcp-by-siep directions for each option on the Main
Menu, arranged in the order of appearance, in Chapters 11, 12,

and 13.

] Chapter 1 1 covers commands thai work on entire disks.

] Chapter 12 covers commands that work on individual files.

Chapter 13 covers commands that work on ProDOS disks only.

Congratulations! 139





Chapter 10

General Instructions
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This chapter shows you how to start the utilities and perform some

of the common tasks involved in using them:

n getting help

n selecting an option from the Main Menu

n specifying the location of disks and files

d selecting files

Q naming disks and files

choosing an operating system

escaping and quilting

LI.se the keyboard to communicate with the utilities even if you also

have a mouse.

Starting up
1 lere's how to start the utilities programs on the system disk:

1 . Put the system disk (or your working copy of it) in the startup

drive.

2 . If the power is off, turn the power on. If the computer is already

on, press Apple-Control-Reset. (Reset is the key marked with a

triangle.)

You see a list of the files on the system disk. (Sec Figure 10-1.)

If you don't see the system disk files, use this checklist to see if you

can correct the problem:

n Is the computer plugged into an electrical outlet'

Is the monitor also plugged in?

D If the computer or monitor is plugged into a power strip, is

the strip turned on?

Is the monilor connected to the computer?

Is the system disk in the startup drive?

Is the computer's power switch turned on?

a Is the monitor's power switch turned on?

n Are ihe monitor's contrast and brightness settings adjusted

correctly?
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Select the file you
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open.

2 ( Disk 1

s c
Version 2.0

Figure 10-1

Files on the system disk

3. Press the Down Arrow until the subdirectory SYS.UTILS is high-

lighted.

4. Open the subdirectory called SYSUTILS.

5. Open the application called SYSUTILSYSTEM.

You see the Main Menu of" the utilities.

Getting help

When you want to find out more about one of the options in the

Main Menu, here's how to get background information on a

function:

1

.

Highlight the option, but don't press Return.

2 . Press Apple-?

You don't need to press Shift to gel the question mark.

In general, help is available when you are in the Main Menu or
when you are specifying the location of a disk or file.
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3- When you've read ihe advice, press Return to get rid or the Help

box,

For advice on what to do next, you can always look jusi above the

line at the bottom ofihe screen. (See Figure 10-2.)
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Figure 10-2

The Main Menu of the utilities

Selecting from the Main Menu
1 tere's how to choose one of the options in the Main Menu;

1 Use the arrow keys to move the highlighting to the function you

want. (See Figure 10-3.)

Notice that the functions on the menu are grouped into cate-

gories devoted to whole disks, individual files, ProDOS disks and

files, and other options.
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2. When you have highlighted the function you want, press Return.

From any point in the utilities, you can return to the Main Menu
by pressing Esc as many times as necessary. You can do thus at

any time.
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Figure 10-3

Selecting; an option

Specifying the location of disks and files

In many circumstances, when you choose an option in the Main

Menu, you see the screen shown in Figure 1CM.
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Specifying the location of your disk

You need Lo tell ihc utilities where lo find the disk you want to work

on. There are two ways to do so: by identifying the physical location

of the disk, and by spelling out the pathname leading to the disk.

First you pick the method, then you give details.

1

.

Speedy the way you want to identify the disk's Location by
highlighting the Slot and Drive option or the ProDOS Pathname

option, and then pressing Return.

If you don'l know die disk's name or don't feel like typing it, you'll

find it convenient to use the slol-and-drivc method. Use the

pathname method when you're not sure which drive a disk is in

or when you want to go directly into a particular subdirectory.

2. If you are providing slot and drive numbers and the numbers

shown are correct, .simply press Return. If you need to change

a number, move the highlighting to the number you want to

change by pressing Right Arrow or Left Arrow; then type the

new number. When both settings are correct, press Return.

2* By the way: You can also move the highlighting by pressing

the Tab key
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If you have chosen to use the ProDOS pathname lo identify the

disk, a message appears giving the name of a disk.

To erase the name completely, press Control-X or type a

slash (/).

To edit the name, press Left Arrow or Right Arrow to move
the cursor (the blinking underline)

To delete the character to the left of the cursor, press Delete.

D To insert characters to the left of the cursor, start typing.

The pathname begins with a stash, followed by the name of the

disk. That's all you need to identify the disk itself. If you want to

work on a file in a subdirectory, you must add another slash, fol-

lowed by the name of the subdirectory. For instance, to indicate

the route lo the files in the subdirectory LETTERS on the disk

TRYOUT, you would type /TRYOUT/ LETTERS and press Return,

For more information about slots and drives, see "About System

Utilities" in Chapter 8.

Selecting files

When you choose one of the utilities that works on files, you're asked

whether you want the operation lo apply to all the files in the disk or

subdirectory, or only to some of them. If you choose all, the oper-

ation begins. If you choose some, you see a list of the files on the

disk or in the subdirectory you specified. (See Figure 10-5.) Here's

how lo select one or more of those files;

1 . Use the arrow keys to highlight a file you want to work with.

2. Press the Space bar to mark the file. (To remove the check mark,

press the Space bar again).

3 . Repeal steps 1 and 2 for each file you want to work with.
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4. When you have marked all ihe files you want, press Return.
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Figure 10-5

Marking files

Naming disks and files

You can use the utilities to rename a file or a ProDOS disk without

changing its content, and to name a disk when you format it. In

general, keep the name short so that you won't have to type much,

but make sure to choose a meaningful name that you'll recognize a

Tew months from now.

In choosing names for your disks and files, keep the following rules

and suggestions in mind:

Begin with a letter.

Subsequent characters can be letters, numbers, or periods. (Do

not use spaces or punctuation marks other than periods.) Where

you would normally put a space, it's often helpful to use a period.

D The names of disks formatted with ProDOS, and of files stored on

those disks, can be up to 15 characters long.
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The names of disks formatted with the Pascal operating system
can have up to 7 characters. The names of Pascal files can have
up to 15 characters.

If you have a number of .similar files, you may want to start their

names with the same few letters. For example, you might name
your letters to your mother Mom J, Mom2, and Mom.3. Because
filenames appear in alphabetical order, related files will show up
together

a You can assign the same name to two different files, as long as

they are in separate subdirectories. But to avoid confusion, it's

best not to do so.

Here's how to create a name from scratch:

1
.
To erase all the characters in the suggested name, press
Control-X or type a slash.

2 . Type the new name.

5 When the name appears exactly as you want it, press Return.

Here's how to alter a suggested or existing name:

1 . Use the following techniques to edit the name:

a To move the cursor (the blinking underline), press Left Arrow
or Right Arrow.

a To erase all characters to the right of the cursor, press

Control-Y.

To delete the character to the left of the cursor, press Delete,

n To insert characters to the left of the cursor, just start typing.

2. When the name appears exactly as you want it, press Return

A pathname provides the utilities with a path leading to a sub-
directory or a file. Here are the rules for creating a pathname:

d Each pan of the pathname begins with a slash.

The first part is the disk name.

D The next part is the subdirectory, or a series of subdirectories, if

needed.
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n The last part is the filename, if needed.

c The maximum number of characters, including slashes, is 64.

For information on renaming files, see "Renaming Files
8
in

Chapter 12, For information on naming a subdirectory and using a

pathname, see "Creating a Subdirectory" and "Selling a Prefix" in

Chapter 13- For information on renaming a ProDOS disk without

changing its contents, see "Renaming a ProDOS Disk" in Chapter

13-

: For Pascal users; You can't rename a Pascal disk with a single

command, as you can a ProDOS disk. You can, however, use

the Duplicate a Disk option (described in Chapter 11) to copy a

Pascal disk and give ihe copy a new name. You can also formal a

new disk wilh Pascal, giving it the new name, and men copy the

files from your old disk lo the new one.

Choosing an operating system

When formatting a disk, you need to decide which operating system

to use. You can choose cither ProDOS or Pascal.

Each application depends on an operating system as a kind of

subcontractor to carry out tasks such as transferring data from a disk

to the central processing unit and back. The application is said to

be based on that operating system. When you save or copy a File

created in that application, you must store it on a disk that has been

formatted for the application's operating system. If you don't, the

application won't be able to retrieve the file later.

To decide which operating system you want to use in formatting a

disk, you need lo know what operating system the application uses.

I! you're not sure, look on the program disk's label or check the

.. ner's guide for the application. You can also use the Catalog a

Disk option in the Main Menu of the utilities to find out what

operating system an application uses.
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When copying files, remember to make sure you are placing the

files on a disk formalted with the application's own operating

system.

Working with Pascal disks and files

Pascal disk names can be up to 7 characters long. Pascal filenames

can be up to 15 characters long.

Some options in the Main Menu work only on ProDOS disks and
files because ProDOS is the only Apple II operating system that

supports subdirectories. The Pascal operating system was designed
for 5.25-inch disks, which can hold only 143K of data. On disks of
that size, subdirectories are unnecessary, so Pascal does not let you
create them. Nor does it let you set up a prefix.

DOS was the original

operating system for the
Appi© II family of computers;
3.3 Is a version number.

Working with other non-ProDOS disks and tiles

You can use the Copy Files option to copy DOS 33 files to disks

formatted with DOS 3.3. (The utilities on the Apple lies System
Disk will not format a disk with DOS 3-3-, you'll have to use BASIC
or a DOS 3.3 utility to do so.)

You can also copy DOS 3-3 files onto a ProDOS disk. This pro

cedure transforms these files into ProDOS files dial can then
be retrieved and read by a ProDOS-based application such as

AppleWorks®. But the original DOS 3-3 application will no
longer be able to retrieve or read the file.

By the way: You can catalog a disk formatted with DOS 3.2 or

CP/M
t
but you cannot use any of the other utility options on

those disks.
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Escaping and quitting

You can return to the Main Menu from anywhere in the utilities

—

just by pressing Esc. If you're not sure whether to proceed with a

function, you can always back out by pressing Esc.

1

.

To return to the Main Menu, press Esc

You may need to follow this step more than once.

2. To leave the utilities from the Main Menu, choose Quit.

You will see a message asking whether you really want to quit.

If you do, highlight Yes and press Return. After a few seconds,

you'll return to the Program Launcher, from there you can start

up another application.

If you want to do some programming, keep the system disk in (he

startup drive and open BASIC,SYSTEM.
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When you're working with
5.25-inch and 3.5-Inch disks, c
volume Is the some as a disk.

In ihis chapter, you'll learn how to use the utilities for tasks involving

whole disks:

cataloging a disk (showing you what files are on it)

u listing volumes (showing what disks are in your disk drives)

duplicating a disk (making a copy)

D formatting a disk (preparing it to receive data)

n verifying that a disk is readable

In addition, the utilities allow you to rename a disk that has been

formatted using the ProDOS operating system; this procedure is

covered in Chapter 13, "Working With ProDOS Disks and Files."

The instructions in this chapter assume that you know how to

start up

D get help

select from ihe Main Menu (Figure 11*1)

specify the location of disks and files

u select files

name disks and Hies

n choose an operating system

See Chapter 10, "General Instructions on Using ihe Utilities," if you

need more information about any of these procedures.

154 Chapter 1 1 : Working With Disks



e !
.

i n
'

'

ESC w I

Options that help you work
with disks

fork i E .

-
:

- :

i Otsl

lor w id! lu Files

PS Fl :

. : Files
' ••

naite f I es
1

: »

il •

..•. ibdirector

1

:

>.'
. . : : Is:

:

Instructions on selecting —

-

o function

Instructions on getting help

"....-;.--'
j

;

-

"

s :-.: : n\

'Of Heit r
-

Figure U-l
The Main Menu of the utilities

Cataloging a disk

You may want to know whai files are on a particular disk or what the

disk's name is. This information is contained in the disk's directory.

When you catalog a disk, you can find out its operating system and
name, the name of every file on the disk, the type and size of each
file, and the amount of space available on the disk.
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Cataloging a disk

1 . In the Main Menu, choose Caialog a Disk and press Return.

2 , If you arc using only one drive, replace [he system disk with the

disk you wish to catalog, If you are using a second drive that can

accept the disk, insert the disk you wish to catalog in thai drive.

3 Choose the way you want to identify the location of the disk to be

cataloged; then specify ihe location of the disk,

When you specify the location of a disk by name or by physical

location, the utilities display a list of the lop level of files but do

nol open any subdirectory. (Sec Figure 11-3) To find out what

files are contained in a particular subdirectory, use the ProDOS
pathname to specify the location of the subdirectory. Type a

slash, the disk name, another slash, and the subdirectory name,

like this:

/TRY0UT7 LETTERS

Then press Return.

The utilities provide a catalog of the files in ihe subdirectory.
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The noma of the disk

The disk operating system used To
formot this disk

The kind of file (depends on which
application you used to create the
file)

Files on the disk

The size of the file, measured In

blocks of 512 bytes

The amount of space still available

on the disk

For more information on slots and drives, see "About System

Utilities" in Chapter 8,
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The Catalog a Disk screen

Figure 1 1-4

Listing volumes

Listing volumes

Sometimes you need lo identify which disk is in which drive. W hen

you list volumes, you see the names and operating systems of all

formatted disks in drives connccied to your computer. You also sec

the slot and drive numbers corresponding to those drives.

If you have a hard disk, you may have carved it up into several

storage areas, known as volumes; if these volumes are

formatted correctly, their names will also appear on your list.

1

,

If you are using one drive, replace the system disk with the disk

you want identified. If you are using more than one drive, make

sure the disks are in the drives.

2. In the Main Menu, choose List Volumes; then press Return.
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You see a list of all the formatted disks you can use, (See Figure

1 1-5.) If a particular disk drive does not appear, make sure that

it has a formatted disk in it and that the connection with the

computer is secure.

The name of the disk in the drive

The disk format

The slot assigned to a disk drive

Figure \ 1-5

The List Volumes screen

Duplicating a disk

Using this option, you can copy all the information from one disk

onto another of the same size.

Important If you have only one drive that can handle disks the same size

as your original, you should choose FastCopy In the System
Disk menu, described in Chapter 8; it you want to copy Just a
few files, you should choose Copy Files in the Main Menu of the
utilities, described In Chapter 12. Using the Duplicate a Disk

option with only one drive is possible, but It involves many disk

swaps and can be a tedious procedure.
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Duplicating a dfsk

1 In Lhe Main Menu, choose Duplicate a Disk and press Return.

2. Specify the location of the source disk (the one you want to
duplicate).

For information on slots and drives, sec "About System Utilities"

in Chapter 8.

3. Specify the location of the destination disk.

You can use an unformatted disk or one with unwanted data on it

as a destination disk. The utilities will reformat the disk before
making the copy, wiping out any existing data, so be sure the
destination disk contains nothing you need. If you have any
doubt, press Esc to return to the Main Menu; then choose
Catalog a Disk and make sure there are no files you still want on
the disk.

'Hie destination disk must be the same size as the source disk. You
cannot use the Duplicate a Disk option to copy the contents of a
3. 5-inch disk onto a 5.25-inch disk or vice versa. You can use
Copy Files, described in Chapter 12, to copy individual files

between disks of different sizes,

4
.
You'll see a message asking you to insert the source and desti-
nation disks. (See Figure 11-7.) If you haven't already done so,
insert the disks and press Return,
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The location of the two disks

The suggested name for the
new volume

5. Accept the suggested name for the backup disk by pressing
Return, or create a new one and then press Return.

See "Naming Disks and Files" in Chapter 10 for a list of rules for

naming disks.

6, If your destination disk has previously been formatted, it may
have some data on it; if so, a message asks whether you want
to destroy the disk. This docs not mean that your disk will be
physically harmed, but before duplicating, the utilities will

reformat the destination disk, erasing any data now on it. If you
are sure you do not need any of the data on the destination disk,
choose Yes and press Return. If you have any doubt, choose \".

;

that takes you back to the Main Menu. Then choose Catalog a
Disk to make sure that the disk contains no files you want to
preserve

HFFii

Figure 11-7
The Duplicate a Disk screen
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Figure 11-6

Formatting a disk

Formatting a disk

Before you can save a document or copy files 10 a blank disk, you
need lo prepare the disk to store data. This process is known as

formatting the disk. Formatting erases any data that happens to be

on the disk, so if you're not sure what's on a data disk thai you're

thinking of formatting, you should first use the Catalog a Disk

option to see what files are there and to assure yourself that you
don't need any of those files.

•> By the way.- You don't have to format a disk if you intend to use

it as the destination disk when duplicating a whole disk; the

duplicating option automatically reformats the destination disk,

wiping it clean so that it can receive the new data.

1
.
In lite Main Menu, choose Format a Disk and press Return.

2 Confirm that you will identify the location of the disk you want to

formal by slot and drive; then specify its location.

For information on slots and drives, see "About System Utilities"

in Chapter 8.

3. Choose the disk operating system required by the application

you'll be using to create files for this disk.

If you are not sure which operating system the application

requires, press Esc to return to the Main Menu, insert the

application disk in your startup drive and use the Catalog a Disk
option. You'll see the name of the operating system at the lop of

the display.

4. Type the name you want to give the disk when it's formatted and
press Return, or accept the one that's suggested by pressing

Return.

See "Naming Disks and Files" in Chapter 10 for a list of rules on
naming disks.

5. When prompted, place the disk you wish to Format in the drive

you specified in step 2. Press Return. (See Figure 11-9.)
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6. If Lhe disk has already been formatted, you will see a message

asking whether It's okay to destroy the existing data on the disk as

part of reformatting it. This does not mean that the utilities will

physically harm your disk, but formatting will erase any data now

on it. If you are sure you do not need any of lhe data on the disk,

choose Yes and press Return. If you have any doubt, choose No
and press Retum; then choose Catalog a Disk to make sure that

the disk contains no files you want to preserve.

The location of the disk you
are formatting

The new name of the disk

Figure 11-9

The Format a Disk screen

In the process of formatting, three things happen;

D The disk is divided into sections where information can be

stored.

A directory—an empty list waiting to record lhe names of files

you save on the disk—is set up on the disk,

D The name you typed or accepted is assigned to the disk as its

volume name.
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Once the disk has been prepared to receive data, it is known as a

volume. You are now ready to save Hies onto ihis disk from any
application that uses the operating system (ProDOS or Pascal)
thai you formatted it with.

Verifying that a disk is readable
Sometimes things go wrong. You may see a message saying that
the computer can't read a file or a disk. Perhaps your application
won't start, or it seems to start, but then garbled characters fill ihe
display. Reinsert the disk, making sure 10 place it securely, check all

me connections, and then Lry again. If you still have problems,
make sure the disk has been formatted for the same operating
system your application uses, and then try again.
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Rgure 11-10
Verifying that a disk is readable

If the disk still can't be read, there may have been some physical
damage to the disk. Here's how to make sure that a disk is readable:

1

.

Tn the Main Menu, choose Verify a Disk and press Return.

2 . Insert the disk.

3. Press Return to confirm mat you will use the slot-and-drive
method to identify the location of the disk; then specify its slot
and drive.
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For information on slots and drives, see "About System Utilities"

in Chapter 8.

If the utilities find errors or problems, use Copy Piles to copy all (he.

files—or any files that you can—onto another disk. Then reformat

the disk and check it again, using the Verify a Disk option. If errors

show up again, try another disk in the same drive. If thai disk can't

be read, have your authorized Apple dealer check the drive. If the

utilities verify other disks in that drive, throw the damaged disk

away.

The message "No errors" means that a disk is undamaged and that

any files on it should be readable by the application with which they

were created. (See Figure 11-11.)

Trie location of the disk —

The result

Figure 11-11

The Verify a Disk screen
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In this chapter, you'll learn about

copying files

i i deleting files

renaming Ales

locking and unlocking files

For files created with an application thai uses ProDOS, you can also

create a subdirectory; that task is covered in Chapter 13, "Working

With ProDOS Disks and Files
"

The instructions in this chapter assume that you know how to

D Start up

a get help

~ select from the Main Menu (Figure 12-1)

specify ihe location of disks and files

a select files

a name disks and files

choose an operating system

See Chapter 10, "General Instructions on Using the Utilities," if you

need more information about any of these procedures.
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The Main Menu of the utilities

Copying files

You can use the utilities to make a copy of one or more files.

Copying with only one disk drive can become tedious. One way to

avoid it is to make more than one copy of a file when you are still in

an application, saving the document to one disk, then saving it

again to another disk. In this way, you can quickly make a backup
copy without having to use the utilities.

Remember that you must copy a file onto a disk that has been
formatted using the same disk operating system as that used by the

application—so that the application can read the file. To ascertain

which disk operating system the application uses, check the label of

the program disk or the owner's guide for the application. You can
also use the Catalog a Disk option.
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Copying files

1

.

In the Main Menu, choose Copy Files and press Return.

2. Insert the source disk (the one with the Tiles you want to copy).

3. Choose the way you want to identify the location of the source

disk; then specify its location.

For information on slots and drives, see "About System Utilities"

in Chapter 8.

4 If you are using more than one drive, insert the destination disk

(the one that will receive the copies) in another drive.

If you are using only one drive, remove the source disk when

prompted and replace it with Lhe destination disk. Press Return.

(Depending on the size and number of the files you're copying,

you may need to exchange disks anywhere from 1 to 80 times to

complete the copying; that's why it's a good idea to make copies

of Files from wiihin the application.)

5. Choose the way you want to identify lhe location of the

destination disk; ihen specify its location.
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6 . Specify whether you warn 10 copy all the files on the original disk

or only some. Then press Return.

If some, press Up Arrow or Down Arrow to move through the list;

mark each file you want to copy by pressing the Space bar. (To

remove a check mark, press the Space bar again.) When you have
marked all the files you want to copy, press Return.

If you try to copy a file onto a disk that already contains a file by
thai name, you'll be alerted with a message like this: "File ALAN
already exists, delete ii?° If you do not want the old version

replaced with your copy, choose No and press Return, saying

that it is not OK. If you want to update the old file, replacing it

with the copy, choose Yes and press Return,

• f„» 1 1 : -: - '

Instructions for this option ftiss r .
- •

•

i «ud mm .« »-«r

Figure 12-3

The Copy Files screen
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Deleting files

Sometimes you need lo free up disk space by permanently erasing

one or more files. You can do so with the Delete Files option.
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Figure 12-4

Deleting files
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—— ^^_^

-J

By the way: If you want to delete every file on a disk, it's faster

to use the Formal a Disk option, which erases all data on a disk

during formatting,

1 . In the Main Menu, choose Delete Files and press Return,

2. If you have a second drive, insert the disk with files to be deleted

in that drive. If you arc using only one drive, be sure to remove

the system disk and replace it with the disk containing the files

you want to delete.

3 - Choose the way you want to identify the location of the disk

containing the files you want to delete; then specify its location.

For information on slots and drives, see "About System Utilities"

in Chapter 8.

170 Chapter 12: Working With Files



4 Specify whciher you want 10 delete all the files on the disk or only

some; then press Return. If some, select the files.

To select the Eles you want to delete, press Up Arrow or Down
Arrow to move the highlighting; press the Space bar lo select

each file. Press the Space bar again to remove a check mark.
When you have selected all the files you want to delete, press
Return.

If a file is locked, you'll be warned before it is deleted; to override

the protection and erase the file anyway, choose Yes and press
Return, To cancel your command, choose No, then press
Return.

Instructions for this option

Figure 12-5
The Delete Files screen
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Renaming files

With this option you can change the name of a file without changing

its contents.
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Figure 12-6

Renaming files

1 In the -Main Menu, choose Rename Files and press Return.

2. Insert the disk that contains the files you want to rename in a disk

drive. If you are using only one drive, be sure to remove the

system disk and replace it with the disk containing the hie.

3 Choose the way you want to identify the location of the disk

containing those files, then specify its location.

To specify a file within a subdirectory, you must use the ProDOS

pathname. For Information about locations, see "About System

Utilities" in Chapter 8,

i specify whether you want to rename all the files on that disk or in

thai subdirectory, or only some; then press Return.
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If some, press Up Arrow or Down Arrow to move through the list,

and press the Space bar to mark each file to be renamed. (Press

the Space bar again to remove a check mark). When you have

selected all files to be renamed, press Return.

5 . For each file, edit the original name, or erase it and type a new-

name. Then press Return,

See "Naming Disks and Files" in Chapter 10 for a list of rules for

naming files.

To edit the original name, press Left Arrow or Right Arrow to

position the cursor; then insert new characters to its left. To erase

the character to the left of the cursor, press Delete. To delete all

characters to the right of the cursor, press Control-Y. To delete

all characters in the original name, press Control-X.

Locking and unlocking files

Sometimes you finish a document, and you don'i want to change
it. You can use the utilities to protect such a file from accidental

changes, deletion, or renaming.

Laicr, if you decide to update the file, you can use the utilities

remove the protection, unlocking the file.
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Figure 12-7

Locking files

Figure 12-8

Unlocking Files
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By the way: You cannot lock or unlock files on a Pascal-

formatted disk, because that operating system does not allow this

kind of protection. To protect Pascal files, write protect the

whole disk. See the Apple IIGS Owner's Guide for information

about write protection.

1

.

In the Main Menu, choose Lock/Unlock Files and press Return,

2 . Insert the disk with the files you want to lock or unlock in a disk

drive. If you are using only one drive, remove the system disk

and replace it with ihe disk containing those files.

3 - Choose the way you want to identify the location of the disk; then

specify trie location.

To specify a file within a subdirectory, you must use the ProDOS
pathname when asked "Where is your disk?"

For information about locations, sec "About System Utilities" in

Chapter 8.

4 . Indicate whether you want to lock or unlock the files.

Move the highlighting to Lock or Unlock, then press Return,

5 . Specify whether you want to select all the files on thai disk or only

some; then press Return

If some, press Up Arrow or Down Arrow to move through the list,

then press die Space bar to select each file, (See Figure 12-9.)

(Press the Space bar again to remove a check mark). When you
have selected all the files you want, press Return,
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The Lock/Unlock Fifes screen
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Mosl or the ulililies on the syslcm disk work with disks and files

regardless of their operating system, Bui ProDOS, the most recent

disk operating system for the Apple II family of computers, offers a

little more than DOS 3-3 or Pascal. In this chapter, you'll learn

about the additional options available when you're working with

ProDOS files and disks:

creating a subdirectory

-iting a prefix

i : renaming a ProDOS disk (known as a volume)

The instructions in this chapter assume that you know how to

n start up

a get help

select from the Main Menu (Figure 13-1)

: specify ibc location of disks and files

select files

name disks and files

choose an operating system

See Chapter 10, "General Instructions on Using the Ulililies," if you
need more information about any of these procedures.
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Figure 13-1

The Main Menu of the utilities

Creating a subdirectory

A subdirectory is like a folder that can contain related files and a list

of those files—a miniature catalog that is subordinate to the main
directory for the disk. Subdirectories help you to keep a disk direc-

tory from becoming cluttered. You can keep a group of related files

in one folder and another group in another folder; dial way, you
won't have lo hunt through a long list to find the one file you need.

Some applications thai use ProDOS take advantage of its ability to

create a subdirectory and save files to it within the application.

Other ProDOS-bascd applications require that you use the utilities

to create the subdirectory. Once a subdirectory has been created,

you can save files to it while in the application by supplying the

pathname that leads to that subdirectory.

Creating a subdirectory 179



r 1

JOHN

N

-

rr^r

BOB CAROL TED

Figure 13-2

Creating a subdirectory

1

.

In the Main Menu, choose Create Subdirectory and press Return.

2. If you are using one drive, replace the system disk with the

destination disk (the disk on which you want to create tlie new
subdirectory). If you have a second drive, insert ihe destination

disk in thai drive.

3. Choose the way you want to identify the location of the disk on

which you will create a subdirectory; then specify its location.

For information on slots and drives, see "About System Utilities"

in Chapter 8.

i . Name the subdirectory.

Sec "Naming Disks and Files" in Chapter 10 for a list of rules on

naming files.

Remember that a subdirectory is itself a file; it just happens to

contain other files—and a list of those files, similar to the main

directory but subordinate to it

You can also create subdirectories within subdirectories. For

instance, on a disk named MYSTL'FF, you could create a sub-

directory called WORK; in that subdirectory you could have two

more subdirectories, one called ACCOUNTS, the other called

LETTERS. And you could son out your letters into further sub-

directories named MEMOS, SUPPLIERS, CONTACTS, CLIENTS
and CONSULTING. Now that's organized!

If you want to create a subdirectory within a subdirectory, you

must use the ProDOS pathname method of specifying the

location of the subdirectory to be created
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IF you were pulling [he letter to your client John in iis

subdirectory, the pathname would be within ihe legal maximum
of 64 characters:

/MYSTUFF/WORK/LETTERS/CLIENTS/JOHN

DISK

DIRECTORY

JOHN BILL MIKE

Figure 13-3

Pulling a file In a subdirectory
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Once you've created a subdirectory, you can use the Copy Files

option to move existing files into the subdirectory; if you arc using a

ProDGS-based application, you can also save any document you've

been working on, using a pathname to place it into the

subdirectory.

Setting a prefix

One of the ways to specify ihc location of a disk, subdirectory,

or Hie is to provide the ProDOS pathname. The pathname is a

sequence of names—the disk name, the subdirectory name if any,

and the filename (if needed). Each part begins with a slash, like

this: /TRYOTJT/LETTERS/ALAN.

There are times when you need to go back to the same disk or Mil >-

directory repeatedly. For instance, you might need to copy a dozen
letters from several different disks into the LETTERS subdirectory on
your backup disk. In such situations, you may find yourself typing

the same parts of the same pathname over and over.

With the Set Prefix option, you can establish a shortcut to a par-

ticular disk or subdirectory so that you don't have to keep typing

part of the pathname. For instance, you could set the prefix to be
,'TRYOIJT LF'IThK.S, Then, whenever you choose to specify a

Ltton by ProDOS pathname, the utilities will present the name
TRYOUT LETTERS/ already entered. All you need to do is press

Return, and the files will be put in that subdirectory. On big jobs,

this option can save you a lot of typing.
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Setting a prefix

1. la the Main Menu, choose Set Prefix and press Return

2. Choose the way you want to identify the location of the disk you're
selling the prefix for—by physical location or by name; then
specify its location.

For information on slots and drives, see "About System Utilities"
in Chapter 8.

*Jhc utilities now provide you with the name of the disk and ask
you to enter the full or partial pathname you want to use as a
prefix to individual filenames.

3. If you just want a prefix that leads lo a particular disk, edit the
name and press Return, or accept the suggested name by press-
ing Return. If you want a prefix that leads to a subdirectory, add
that part of the pathname and press Return. (See Figure 13-5,)

Setting a prefix 183



For instance, if you specify the disk in slot 5, drive 2, and that

disk luras out [Q be TRYOUT, you can simply press Return if all

you want is to return lo that disk over and over. Bui if you want to

return specifically to the subdirectory LETTERS on the disk, you

add the subdirectory name, so that the prefix becomes

/TRYOUT/LETTERS. Then you press Return,

Once youVe set the prefix, you can choose the ProDOS path-

name whenever asked to specify the location of a file you want to

work with. The pathname will appear with the prefix already

entered; all you need to do is press Return to accept it.

The prefix stays set until you change it or turn off the computer,

You can always override it temporarily by editing it, so that you

can go lo another disk, subdirectory, or document. But the next

lime you need to specify a document's location, the computer

will suggest the original prefix.

To i hinge the prefix, follow the steps for setting a prefix and then

edit it.

I'M-ltBtVUZnU
r

'•'.'.'

-

ESC Hi i -

Figure 13-5

The Set Prefix screen
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Renaming a ProDOS disk

Renaming a ProDOS disk

As you save more and more files on a disk, you may find thai ihc
disk's name no longer describes its contents, "JTie Rename Volumes
option lets you change the name of a disk without changing its

contents. You can do this only with disks formatted with ProDOS.

1
In the Main Menu, choose Rename Volumes and press Return.

2. If you are using only one drive, replace the system disk with the
disk whose name you want to change. If you have a second drive,
put the disk to be renamed in that drive.

3. Confirm that you will identify the location of the disk by slot and
drive; then specify its location.

4 Edit the disk's name. (See Figure 13-7.)

See "Naming Disks and Files" in Chapter 10 for a list of rules on
naming a disk,

-.'".. I* ''CI S:

la r -

Figure 13-7

The Rename Volumes screen
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Making mistakes is pan of Lhe learning process. In faci, if you don't.

make a few mistakes, you're probably not being very adventurous. If

you hear a beep and see a message you don't understand, find the

message in this alphabetical list and follow the troubleshooting lips.

An attempt to read or write data on a disk was unsuccessful

Make sure a correctly formatted di.sk is in the drive. With a 5.25-inch

drive, close the drive door. Tighten all connections between drives

and the computer. To make sure the disk itself is readable, choose

Verify a Disk. If you specified a slot and drive, make sure those

numbers are correct. (See "About System Utilities" in Chapter 8.)

An error occurred

Perhaps you entered a filename at (he end of the pathname. For

some operations, that's going too far. The prefix should lead to a

volume (the disk) or a subdirectory full of other files—not to a

particular file. Press Return, then delete the filename at the end of

the pa illname

You may also have entered the volume name or subdirectory name
incorrecdy. If you have any doubts about the spelling of cither

name, press Return, then press Esc and choose Catalog a Disk to

check.

Beepl

You've tried to do something that the application does not allow.

For instance, in typing a pathname, you've tried to use some
character other than a letter, number, or period. Or in naming a

file, you've tried to use too many characters. The application

prevents you from making the mistake and warns you with a beep.

Delete files in the subdirectory?

If you intend to delete every file within the named subdirectory,

choose Yes To preserve the files within that subdirectory, choose
No.
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Different volume sizes

As a safely precaution, the Duplicate a Disk option does not even
begin to format the new disk if it's a different size from the original.

(To do so would shrink an 800K disk lo l'BK, or risk trying to put
800K of files onto a H3K disk, thereby losing or damaging data.) If

you want to copy data among disks of different sizes, use the Copy
Files option to copy individual files instead of a complete volume.

Disk Is full

You've run out of room on the disk. To squeeze any more files onto
the disk, you must delete one or more of the files now on the disk.

Use Catalog a Disk to find out how much room is left and how much
space each file lakes up, then use Delete Files to remove as many-
files as necessary. Tf you do not want to delete any files, put the new
file on another di.sk

Disk Is write protected

Make sure you have the correct disk in the drive.

Before overriding the write protection on a disk, decide whether
you really want to allow changes to be made to these files. (You may
have had a good reason to protect them.) To remove, protection
on a 5.25-inch disk, remove the adhesive write-protect label and
reinsert the disk. To remove protection on a 3.5-inch disk, slide the
wriie-protect tab to close the square opening in the corner of the

disk.

Duplicate fit© or subdirectory name

To avoid confusion, the utilities will not lei you put two files with the
same name on the same disk or subdirectory. (You can put files with
the same name into two different subdirectories on the same disk if

you wish.) You have three choices in this case: give this file a new
name, put it on another disk, or put it into another subdirectory.

Duplicate volume names

Change ihe name of one disk, using Rename Volumes. Then you
can copy the files. (The utilities use the volume names as a way of
distinguishing the source disk from die destination disk)
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Error code= xx

Unanticipated error. Write down the error number and consult your

authorized Apple dealer.

File is locked, delete it?

You once wanted to protect this document from changes. The

warning gives you a chance to preserve it. If you realize you want to

preserve the file after all, choose No. If not, choose Yes.

File is locked, rename It?

You once wanted to protect this document from changes. The
warning gives you a chance to save its name. If you realize that you

want to preserve the name after all, choose No. If not, choose Yes.

File or subdirectory not found

Make sure you have the correct disk in the disk drive.

Use CataJog a Disk to check the spelling of the volume name and any

subdirectory or filename.

File X already exists, delete it?

In copying this file, the utilities have found a file with the same name

on the destination disk. If you want the copy from your source disk

to replace the version on your destination disk, choose Yes. If you

don't want to lose the version on your destination disk, choose No.

Incorrect disk format

You've tried to create a subdirectory, set a prefix, or rename a

volume with a disk that has not been formatted with ProDOS. II the

disk contains valuable data, you should step the operation now.

If you don't mind erasing the contents of the disk, you can format it

with ProDOS and then proceed.

Incorrect pathname

Begin with a slash, then type the disk name, another slash, and, if

needed, the name of the subdirectory. The first character of the disk

name or subdirectory name must be a letter. A ProDOS filename

can be no longer than 15 characters.
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Make sure that you have not tried to use the Rename a File option to

move this file onto another disk. (Use Copy Files for that purpose.)
Renaming must leave the file where it is, changing only the name.

Slol and drive numbers...

See "About System Utilities" in Chapter 8.

Volume directory full

The disk may not he full yet, but you have tried to use more than the

maximum of 51 filenames per directory. You can copy some files to

another disk and then delete their originals here-, you might also
want to create a few subdirectories and copy some files into them.
Either way, you will have fewer names on the volume directory and
more room for new files,

Volume not found

Make sure that you typed the disk name correctly and that the disk is

securely placed in the drive, If you are using a 525-inch disk, be
sure to close the drive door. If you think you may have forgotten the
disk name, choose List Volumes or Catalog a Disk.
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An AppleTalk network links

computers so that a group
of users can exchange in for-

ma Hon ana share peripheral
devices.

About network utilities

In addition to the utilities that let you copy, delete, rename, and
otherwise manipulate the information on disks, there are also

utilities on ihe system disk for AppleTalk network users. 'I

utilities, called the Namervnd the < let you name ihc

printers you share with others on an AppleTalk network and choose

which of those printers to print with.

If you have two LaserWriter39 printers or two ImageWriter35 printers

on your network, it's important to have some way of distinguishing

ihc-m so you know where to look for your printed document (II you

mly one LaserWriter, you don't really need to name it—it's

called LaserWriter^ you don't name it something else—but for the

same reason thai people name cars and boals, you might enjoy

giving your printer a name.) Naming a printer is something that

anyone on the network can do, but it needs to be done only once,

by one person,

The Chooser Is a program that lets you designate which network

printer to u.se. Once you choose a printer, your choice is recorded

on the disk containing the Chooser. You won't need to use the

Chooser again unless you want to pick a different printer or unless

you are the first person tc» use a LaserWriter since it was turned on.

By the way: To use an lm ageWriter as a network printer, you
need 10 install the ImageWriter AppleTalk card in your

ImagcW i in-'

Preliminaries

Before you can use the Namer or the Chooser, your computer must

be ron netted to the AppleTalk network (see Figure A-l) and your

computer's Control Panel must be set up for using AppleTalk (see

Figure A-2). If you need instructions on using the Control Pa

refer to the Apple t/GS Owner's Guide.
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Figure A-l
The AppleTalk cabie plugged in

Slot 1: Your Cord
y Slot 2 HodemPort
v Slot 3: Built-in lext Display
v'Slot H Mouse Port

• Slot 5 Sraorl Port

vSlotfi Disk Port

tlHMfl Built-in Hpplelalk

Startup Slot 5

Selfc f Cancel. Esc Sove;*J

Figure A-2
The Control Panel set up

Once your computer is set up and configured for using AppleTalk,

you can name the printers on lhe network by using the Namcr,
choose one of them lo use for priming by using the Chooser, and
print to thai printer from your application—provided your appli-

cation uses a version of ProDOS lhal supports Lhe AppleTalk net-

work (version 1.2 or a later version) and has been configured to

print to a k printer

You'll find instructions at the end of this appendix on how to

prepare AppleWorks for use with a network printer

Using the Namer
1

.

Turn on the printer you want to name.

2. Start up the system disk, open the subdirectory called APPLE-
TALK, and then open the application called NAMER. 11. When

ii i, von II sec the screen shown in Figure A-3.

3. Choose the type of primer you warn Lo name by clicking it. The
cursor becomes an hourglass white the Namer checks the network
for all printers of mat type and displays a list of primers and their

current names in the Names window
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A . Choose the primer you want to name from the lisi of printers

shown on the left side of the Namcr screen by clicking the

printer's name. The insertion point automatically moves to

the new name box.

5 . Type a new name or edit the current name.

6. Click the Rename button.

7. Click Quit.

Important If you change the name of a printer, you should inform every-

one on the network,- they'll need lo use the Chooser to choose
the new name before they can print anything.

Homer 11 Vw 11

Select the type of device to

ftaoleTalk ImogeWriter

LaserWriter

Available LaserWriter* Hew name of LosetWmei

LaserWriter Plus Ky device's Hone

ienaic

Quit

Figure A-3
The Namer

Using the Chooser
1 Start up the system disk, open the subdirectory called APPL1'.

TALK, and then open the application called CHQOSER.il.
u do, you'll see the screen shown in Figure A i

2 . Choose the type of printer you want to use by clicking it.
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Choosing a zone If your network is subdivided into several

AppleTalk zones, choose the zone lhat your printer belongs to

by clicking the zone name.

3- Choose the printer you want to use from the list of printers shown
on the right side of the screen by clicking it. Click the printer

name or press Return even if the name is already highlighted.

& For LaserWriter users, If you're printing with a LaserWriter,

you'll see a message lhat says "Checking for presence of

ImagcWriter emulator." If no one has printed with that

printer .since ii was turned on, you'll also sec the message
"Downloading ImageWriler emulator." (The ImageWriter

emulator is a program that makes it possible to use a

LaserWriter with any application designed to print with an

ImageWriter.)

4. Click the User Name box and type your name. Some applications

use the information in the User Name box to let other people
know who is currently using the printer.

5 , Choose Quit from the Quick menu.

3 Quick

; Chooser II Ver 1.1

Devices

AppleTalk ImageWriler

Select o LaserWriter

LaserWriter Plus

flpplelalk Zones

roduction

Video

User Hone Rocky

Figure A-4
The Chooser
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Select a device oD
Choose a zone ol
Select a device nanipnH
fnter user name 511

Select Serial Port •i

Quit >Q

Figure A-5
The Quick menu

Keyboard shortcuts: You can also » Rings in the Namer
and Chooser by using the keyboard Pressing Tab mov^ the

i on lo the next box, Pressing one of the arrow keys selects a

new Item, Pressing Return chooses the selected item.

More choices: '\"he Quick menu gives you two more ways to m
from one box to another You can choose the category you v

from the menu or use the keystroke equivalent listed in the menu.

(See Figure A-5.)

Preparing applications for network printing

The Chooser must be on your startup disk in order for you lo use

network printers.

II your application disk doesn't have a Chooser, start up the system

disk. Then use the Program launcher to start the program you want
to use.

I! yout :

i
j 1

1 1 J i
. ation isn't cop) protected, you might want lo copy

• application files to a copy of your system disk so that the

Chooser and the application will be on die same disk.

The following instructions explain how to copy an application

program like AppleWorks to a copy of the system disk and how lo

;re AppleWorks lo print will i a network printer.

1

.

Make a copy of the system disk.

2. Delete the SYS.UTILS folder from your copy of the system disk

to make room for the AppleWorks files. (This deletes System
Utilities, but you shouldn't need the utilities with AppleWorks.)

ipy i he contents of your AppleWorks program disk to the

tern disk When von are asked whether you want to copy over
the file called PRODOS, answer \o.
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Important There Is already a copy of the file called PRODOS on the system
disk, and It's probably o more recent version of the file than the
version on your AppleWorks disk. You need version 1 .2 of the
ProDOS operating system (or a later version) to be able to print
to a network printer.

ipcdfy information aboul your network printer:

the Program Launcher to open the application called

APLWORKS.SYSTEM.

Choose Other Activities from the Main Menu

• Select "Specify information aboul your printer(s).
B

Select "Add a primer.'

Select "Apple Imagewritcr" (even if you'll be printing with a

LaserWriter).

Type the name of one of your network printers.

Select Slot 7

D Select "Interface cards,"

- If any control characters are listed, press Return to select No
and then type A CShift-6). If no control characters arc lisl

simply type \

i thai you ve copied AppleWorks to tin- system disk and
configured AppleWorks for use with a network printer, you'll never
need to go through those steps again From now on, all you need to

do is start up the copy of the system disk that has AppleWorks on it

and then start up AppleWorks,

<• By the way.- The LaserWriter gives you a choice of fonts. The
ill is Courier, To change to Times, choose Proportional 1 or

2 in the AppleWorks Option menu. (Proportional I gives a
condensed version of Times, Proportional 2 a i Lcnsed
version, Experiment to see which version you prefer)

* Preparing other applicationsfor network printing; Different
applications have different ways of asking for information aboul
your printer. If the application asks for the slot number of your
network primer, choose slot 7.
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Glossary

active window: The window that is the scene of

the next action you perform. The active window
appears in front of all other windows on the

desktop, 'in n i.ike ... wind w active, dick anywhere
in the win

AppIeTalk network: A system of interconnected

computers that allows a group of users lo exchange
information and share peripheral devices.

application: A program that puts the resources of
the computer to use lor some specific purpose,
such as word processing.

hack up: To make a spare copy of a disk or file, to

e that you won't lose information if the

original is lost or damaged.

backup copy: An extra copy of a disk or file, made
as insurance against any disasters that might bet ill

the original.

based: When an application relics
i

i to send information to d:

receive information from disks, and perform
oilier

< hones, thai application is based on the

operating system. For instance, AppleWorks is

ProDOS-based.

BASIC: A programming language built into the

Apple IIGS. The system disk contains extensions of
thai it vi] save and load BASIC programs

on disl 1 with the Pro! M >S operating

em

blank disk: A disk that has not been formatted

to receive information and therefore has no files

on it.

block: A unit of information 512 bytes (roughly

512 characters) long. A 5.25-tnch disk contains

280 blocks A 3-5-inch disk contains 1600 blocks.

button: The place in a dialog box where you click

to designate, confirm, or cancel an action.

byte: A unit of information large enough to

represent a single letter, number, punctuation

mark, or oilier character.

Cancel burton: One of the buttons in a dialog

box. Clicking the Cancel button cancels the

command.

card: A circuit board that plugs into one of the

computer's expansion slots, allowing ihe

computer to use one or more peripheral devices

Such as disk drives.

catalog: In the System Utilities, to list all files

stored on a disk.

central processing unit (CPU): Hie "brain" of

the computer, the microprocessor thai performs
the actual computations

character: A symbol such as a letter, number, or

punctuation mark.

checkbox: Ihe small box associated with an
option in a dialog box; when clicked, the check
box activates or deactivates the option.
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choose: To pick a command from a menu by

niv-V Usually, you choose a command aflet

y hi have selected something for the Finder to act

i ii'.

click: To position the pointer on something and

then to press and quickly release the mo
button.

clipboard: The holding place for what was last cut

or copied. You use the Finder's Show Clipboard

command to view the contents oi the clipboard.

close: To collapse a window Into the icon that

represents it. To indow, you click the

window's close box.

close box; The small, while box on the lefi end of

the title bar of an aedve window Clicking the close

box doses the window

command: A communication from you Jo the

computer, telling it to perform some immediate
1 >n.

cop) -

: To duplicate a Hie, folder, or disk. The
liliiies and the Finder can make copies

for yi

cursor: The blinking markei thai indicates where
whai you type will appear.

default: A preset response to a question or

prompt, or the option that is chosen if you dnn'i

some other option; usually the expected or

in'. '••'
i ' unmon res]

delete: In the System Utilities, to remove a file

from a disk, leaving space available for other files.

When editing, to erase one or more characters.

desk accessory': A 'mini-application" available

on the desktop from the Apple menu, regardless of
which application you are using.

desktop: The Finder's working environment. The
desktop includes the menu bar and the gray area

on the screen.

destination: The disk, volume, or folder into

which you are copying. The source is the disk,

volume. Folder, or file you want to copy.

device: A physical apparatus forming a

particular task—for instance, a disk drive, a

monin ir, ir a keyboard.

dialog box: \ box that appears on the screen to

provide information and, in some cases, to

request a response from you.

dimmed command: A command that you can'l

choose under the present circumstances. When
you choose a dimmed command, the Finder

displays a dialog box telling you how to activate

the command. You can turn off this option using

Preferences,

dimmed icon: An icon that represents a disk that

has been ejected or a file or folder on a disk that

has been ejei

directory: A list of the contents of a subdtrc

or folder, or a list of ihe contents Of a disk

disk: A flat, circular, magnetic surface, serving as

a medium for storing information. A RAM disk is

memory that (unctions as a cross between

random-access memory (RAM) and a disk.

disk directory: A list of the files and folders on a

disk. The disk directory does not include files or

folders that are nested inside folders.

disk operating system: Software that enables

your computer to communicate with its disk

drives,

document: A named collection of meaningful

data, created by an application program and

so wed on a disk as a File.

DOS 3.3: One of three operating systems used by

the Apple I Ids; DOS is an acronym for disk

operating system; 3-3 is the version number.
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double- click: To position the pointer where you
want an action to take place and then to press and

nouse button twice in quick succession.
You double-click an icon to open it; you double-
click an icon's name to .select it for renaming.

drag: To position the pointer on something, :

and hold down the niou.se button, move the

mouse, and then release the mouse button.

drive: A device that reads and writes inform
on ,i disk.

duplicate: in the Finder, to copy a file or folder in

the same folder or disk director,' as the original In
•Mean I 'li lilies, to copy the coi one

another.

Esc: Short for Escape. Pressing (he Esc key car

an operation and returns you to the Main Mem. I

the System Utilities.

file: A named collection of informal!'
i d on

a disk.

Finder: A utility used lo start up ProDOS-1
applications and i

i opy, move, delete, and
otherwise manipulate information stored on disks.

F1NDER.DA.TA: A file stored on a disk thai

'remembers" the color and position of the i\ >ns

in a window and the size and location of the
window on the desktop when you close the window.

l'l.XDER.ROOT: A file stored on a disk that

"remembers" the windows that were open when
you last ejected the disk or quit the Finder and
opens those v [he nexi Lime you place the
disk icon on the desk]

5.25-inch disk: A fie disk, 5 25 inches
itnc-ter, with a thin, flexible plasti< jacket

floppy disk: A disk made of flexible plasti

opposed to a hard disk, which Es made of i

T usually ii

folder: In the Finder, a place Lo store relat

documents, applications, or other folders on the
desktop. Compare subdirectory.

format: To prepare a disk »o store information.

You must formal a blank disk or a RAM disk Iv
I

you can save documents or applications on it.

Same as initialize.

hard disk: A desk made of metal and scaled into a

drive Or cartridge. A hard disk can store much
information than inch disk or a 3.5-

inch disk.

highlight: in the System Utilities, to move the

bright bar over an option, indicating that you
want lo select it. In the finder, an icon is said to

be highlighted when it has been selected.

icon: A graphic representation of an object,

concept, or message.

initialize: 'I o prepare a disk to store informa-

tion. You must initialize a blank disk or a RAaM disk

m can save documents or applications on
it, Same as format.

interface card: A circuit board that manages the

interface (connection) between ihc computer and
a particular peripheral device, such as a printer, a

disk drive, or a modem.

kilobyte (K): Two to the tenth power (1024) bytes

(from the Or<:ek root kiln, meaning thousand); for

example. 256K of memory equals 256 times 1024

bytes, or 262, 1

list: In the System Utilities, to display the contents

of the disk directory on the screen or on paper.

lock: To prevent a file or folder from being
renamed, replaced, or removed,

megabyte (MB): Two to the twentieth power
iytes (from the Greek fool mega,

meaning million). One megabyte equals 102*3

kfldbyi

memory: A hardware i omponent of the

computer; memory holds information

temporarily for later retrieval
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memory expansion card: A circuit board thai

adds exira random-access memory (RAM) to your

computer, the card comes with 256K of RAM but

can be expanded to 512K, 768K, or 1 megabyte.

You can designate all or part of Lhe memory on a

memory expansion card as a RAM disk.

menu: A list of choices presented by an appli-

cation,, from which you can select a command.

menu bar: The horizontal strip at the lop of the

Finder desktop that contains menu lilies.

move: In the Finder, to transfer a file to another

folder or disk,

open: To retrieve an existing file from a disk,

bringing the information back into the computer,

usually for display on lhe screen, where you can

read it and revise ii. In the Finder, to expand an

icon into a window or to launch an application.

operating system: Software thai organizes

the actions of the parts of the computer and

communicates with peripheral devices such as

disk drives.

partial pathname: In the System Utilities, the

portion of the pathname following the prefix.

The prefix provides the volume name (and

subdirectory name if needed); you provide Lhe:

rest of the pathname leading to a particular file.

Pascals An operating system and a programming

language. The System I
ulities program works with

the Pascal operating system, version 1.3

pathname: The full name by which an operating

system locales and identifies a file. The pathname-

specifics the path from the disk, through any

subdirectories or folders, to the file itself. Each

pan of lhe pathname is preceded by a slash.

peripheral device: Any physical apparatus for

performing a particular task outside the main

circuit board of the computer, thought of as at tile

periphery of the computer. Examples: a disk

drive, a monitor, a printer.

pointer; In the Finder, a small visual device on

the screen, most often an arrow pointing up and to

the left, thai tracks the movement of the mouse.

prefix: In the System Utilities, a stored pathname

that is placed in front of any subdirectory name Of

filename you provide.

ProDOS: An acronym for Professional Disk

Operating System. An Apple II operating system

designed to support subdirectories and large-

capacity disks.

program: A set of instructions conforming to the

rules and conventions of a particular program-

ming language, telling the computer to perform a

series of actions designed to accomplish a task

such as word processing, A program relies on the

operating system co move data back and forth

between the computer and disks.

proportional scroll box: The white box in the

scroll bar. In the Finder, the position of the scroll

box in die scroll bar indicates which part of lhe

directory is displayed in the window. Dragging the

proportional scroll box changes the portion of lhe

directory that's displayed.

RAM: An acronym for random-access memory.

Computer memory that can be read from or

written to in any order; the content of indiv
i

locations within RAM can be referred to in a

nonsequential or random order. Your application

program and its data are stored in RAM while you

work When you turn off the power, all information

is erased from RAM. Thai's why you should save

your documents regularly to a disk, a storage

medium that preserves your information even

after you turn off the power.
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RAM disk: A cross between a disk and random-

access memory, Like a disk, it must he formal ted

wiih a particular disk operating system to store

data. Unlike a disk, it acts like the random-access

memory inside the computer, so that any data or

program you put on the RAM disk can be read and
used almosL immediately, without making you wait

while data comes in from a disk in a disk drive. If

you have a memory expansion card connected to

your Apple IIGS, you can designate a portion of

the memory on the card to be used as a RAM disk.

read: To transfer information into the computer's

memory from a disk. You can use the System
Utilities to verity that a disk is readable.

rename: To give a new name to a file, folder, or

disk.

save: To preserve a document by storing it on a

disk.

scroll: In the Finder, to move a directory in its

window so that you can see a different portion of

the directory

scroll arrow: An arrow on either end of a scroll

bar. In the Finder, clicking a scroll arrow moves
the directory one lii inning the pointer on
a scroll arrow and holding the mouse button down
scrolls the directory continuously.

scroll bar: In the Finder, the long bar at the

bottom or on the right side of an active window
that lets you change the portion of the directory

visible in the window.

scroll box: See proportional scroll box.

select: To designate where the nexi action will

take place. To select an icon, you click it; to select

text or a group or icons, you drag across it.

Shift-click: A technique for selecting and
deselecting icons. You Shift-click by holding

down the Shift key while you click the icon you
wan! to select or deselect

size box: A box in the bottom-right corner of a

window thai lets you change the size of die window,

slot One of the narrow sockets inside the

Apple IIGS that let you connect interface cards

for attaching printers and other devices to the

computer.

smart block copy: In the Finder, a disk-copying

procedure in which only those blocks that contain

information are copied.

source: The disk, volume, folder, or file that you

want to copy. The destination disk, volume, or

folder contains die copy.

start: To launch an application program. Note

that some application programs come on two
disks, a stanup disk and a program disk, use the

startup disk first.

startup drive: The disk drive from which you

started your application.

subdirectory: In the System Utilities, a file you
create to serve as a place to store related docu-

ments; it has its own list of these documents, a

directory within the disk directory,

system file: A file that starts an application.

When you want to start a ProIX)S application after

quilting the System Utilities, you provide the path

name leading to the application's system file. It's

the one whose name ends in .SYSTEM,

title bar: The horizontal bar at the lop of a win-

dow lh.it shows the name of the disk or folder

that die window represents and lets you move the

window.

Trash: In the Finder, an icon that represents the

place where you discard files and folders when you

no longer need them.

unlock: To remove the restriction on a file or

folder so that it can once again be renamed,

replaced, or removed. Compare lock.

utilities: Useful programs with which you can

copy, delete, format, rename, and otherwise

manipulate files and disks. The System Utilities

and the Finder arc examples of utilities,

verify: To make sure that a disk can be read.
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volume: A general term referring to an area in

which you can store data, U you are using 3.5-inch

disks or 5.25-inch disks, a volume is a formatted

disk. If you are using a hard disk, its manufacturer

may provide software to divide its storage area into

several smaller areas, each known as a volume.

volume directory: With 3 5-inch disks and 5.25-

inch disks, the main directory of a disk, containing

the names, si7.es, types, and locations of files on
the disk. Those files may be documents, applica-

tion programs, or subdirectories.

volume name: The name of a formatted disk,

window: The area on the Finder desktop that

displays information. You view a directory

through a window.

write: To transfer data from the computer to some
destination outside the computer, such as a disk or

a piece of paper in your printer.

write-enable notch: The cutout on the side of the

jacket of a 5.25-inch disk. When uncovered, the

notch allows the disk drive to write information

onto the disk.

write protect: To protect the information on

k horn being changed or written over. You
protect a 5.25-inch disk by covering the write-

enable notch (.die cutout on one edge of the disk

jacket) with an adhesive wrlte-proted label, which
prevents die disk drive from writing new informa-

tion onto the disk. You protect a 3.5-inch disk by
sliding the write-prolect tab to uncover the square

opening in the corner of the disk.

zoom box: The small box on the right end of a

window's title bar. Clicking the zoom box expands

the window to its maximum size. Clicking it again

returns the window to its original size.
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Index

AbouL ihe Finder command
(Apple menu) 82

active window 18, 27-28

APLWORKS. SYS'JiM

application 199

Apple-? 113, 143-144

Apple-A 93

Apple-Control-Resel 123, 142

Apple-D 93

Apple-E 93

Apple-1 93

Apple key 29

Apple menu 82

About the Finder command 82
Help command 82

Apple-N 93

Apple-O 12, 93

Apple-period 111

Apple-Q 93

Applc-R 93

Apple-T 93

AppleTalk network 194-195

zones and 197

AppleTalk network utilities

194-199
APPLETALK subdirectory 195.

196

AppleWorks, preparing for network

printing 198-199
application icons, starling up

applications from 79
applications

preparing for network printing

198-199

starling up with Finder 17-20,

78-80
starting up with Program

Launcher U0

backing up. See copying entries

UASICLSYSTEM 152

blocks 23, 46, 91

By Dale command (View menu) 88
By Icon command (View menu)

16, 87

By Kind command (View menu) 88
By Name command (View menu)

16, 88

By Si/e command (View menu) 88
Hy Small Icon command (View

menu) 8H

cards 116-117

catalog. See directories

Catalog a Disk opiion (Main Menu)
126, 150, 156

Catalog a Disk screen 126, 157

cataloging disks (with System

Utilities) 126-128, 155-157
check mark 147

Chooser 194-195, 196-199

GH005ER.il application 196

choosing primers. See Chooser

Cleanup command (Special menu)
89

clipboard 87

Close All command (File menu)
84-85

close box 8, 20, 26, 27, 31

Close command (File menu) 31,

83-84

closing windows 20, 30-31

Color menu 5, 91-93

"Color selected icon's background

instead of its outline" option

90, 92

command(s)

About the Finder 82

By Date 88

By Icon 16, 87

By Kind 88

By Name 16, 88

By Size 88

By Small Icon 88

Cleanup 89
Close 31, 83-84

Close All 84-85

dimmed 12, 82

Duplicate 63, 86, 93

Eject 56, 80, 93

Empty Trash 73. B9, 93

Erase 54

Erase Disk 90

Get Info 76. 85, 93
Help 82

Initialize Disk 90

New Folder 59, 85. 93
Open 12, 42, 60, 83, 93
Preferences 55, 90-93

Print 83
Put Back 74, 86
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Quit 86, 93

ovc 74, B

Rename 39, 86
Select All 35, 89, 93

jw Clipboard 87

Compare Disks option

(FastCopy menu) 115-116

comparing disks (with FastCopy)

115-116

ControUF 38
Control key 37

Control Panel 194-195

Conlrol-X 37

Conlrol-Y 38

Copy Disks option (FastCopy

menu) 113-115
1

'
ip\ Disks screen 113

Copy Files option (Main Menu)

134, 151. 158, 168, 182

Files screen 169

copying disks

with FastCopy 113-115

with Finder 22-24, 46-53

With System Utilities 158-160

copying files (with System Utilities)

134-138, 167-169

copying files/folders (with Finder)

6l

into same folder 63

onto different disk 67-71

options for 71-72

summary 62
1 urier Ibnl 199

CP/M 151 See a Iso operating

i em s

Create Subdirectory option

(Main Menu) 132, 180

Delete Files option (Main Menu)
170

Delete Files screen 171

Delete key 37, 38

deleting

files (with System Utilities)

170-171

text (with Finder) 37-38

deselecting e also selecting

desk accessories 82

desk iop. See Finder

destination disk 46, 62

destination folder 62

dialog box 23, 36

dimmed commands 12, 82

directories 13, 39, 44, 126, 162

discarding files/folders (with I-"inder)

into Trash 73

using Remove command 74

disk(s)

backing up with Finder 22-24

cataloging with System Utilities

126-128, 155-157

comparing with FastCopy

115-116
copying with FaslC ipry I i J—] 15

copying with Finder -16—53

copying with System Utilities

158

destination i6, 62

ting with Finder 55-56

erasing with Finder 54

Finder and 4

formal! ing with System Utilities

122-126, 161-163

initializing with Finder 20-22,

44-16

listing with System Utilities

157-158

naming with System Utilities

148-150, 185

opening with Program Launcher

111

source 46, 62

System Utilities and 120-121

verifying with System Ft

163 164

write protecting with Finder 6

See also 5.25-inch disks; hard

disk; RAM disk; 3-5-inch disks;

volumes

Disk Qipy Alternatives dialog box

51-53

disk directories. .See din

disk drive icons, opening 42-44

disk drive port 1 |6-1 17

disk drives, slot equivalents of

116-117

disk icons 43
opening i2-i i

"Display help for dimmed menu
commands" option 82, 90

"Do a smart block copy when
copying disks of the same

size" option 91

document icons, starting up

applications from 79-80

"Don't replace any duplicate items"

burton 52, 66, 70, 72

"Don't replace this item" bull on

52, 66, 70

DOS 3 2 151. See also operating

i ems

DOS 3-3 xv i, 151

starling up applications with 78

See also operating systems

"Double-check before removing

files and folders" option 74,

89. 90

double-clicking 17, 37, 110

drive number 12 i, 127, 132, 146

Duplicate a Disk option (Main Menu)

150. 158, 159

Duplicate a Disk screen 160

Duplicate command (File menu)

63, 86, 93

duplicating disks. See copying disk 1
-

Fdit menu S~

Show clipboard command 87

eject button (disk drive) 56

Eject command (Special menu)

56, 89,

1

i'
urig disks (with hinder) 55-56

empty folder 85

Fnipty Trash command
(Special menu) 73, 89, 93

Erase command (Special menu) 54

Frase Disk command
(Special menu) 90

erasing disks (with Finder) 5 1 See

also initialising disks

error messages

Finder 96-104

System Utilities 188-191

i ii 152

escaping System Utilities 152
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FastCopy 108. 111-116, 158
RAM disk and 1 I 2

Fa.stCopy menu 112

Compare Disks opLion 115-116
v Disks option 113-115

FASTCOPY SYSTEM 112
File Copy Alternatives dialog box

72
File menu 11, 83-86

Close All command 84-85
Close command 31, 83-84
Duplicate command 63, 86, 93
Gei Info command 76, 85

1 93
New Folder command 59, 85

93

Open command 12, 42, 60, 83
93

Print command 83
Put Hack command
Quit command 86, 93
Rename Command 39, 86

files

copying with Finder 61-72
copying with Finder into same

folder 63-64
ng with Finder onto

different disk 67-71
copying with Finder, options for

71-72
i pyiflg with System Utilities

134-138, 167-169
deleting with System Utilities

170-171

discarding with Finder into Trash

discarding with Finder using

Remove command 74
Finder and 5

locking with Finder

locking wiih System Utilities

173-175
moving with Finder 61-72
moving with Finder into folder

on same disk 64-67
moving with Finder onto

different disk 67-71
moving with Finder, options for

71-72

naming with System LTtil

148-150, 172-173

recovering with Finder from
Trash 74

selecting with System Utilities

147-148

System Utilities and 121

unlocking with finder 75-76
unlocking with System Utilities

173-175
Finder xv-xvi, 4-5

disks and 4

files and 5

memory requirements for

xv-xvi

starting up 7-8

lroubleshooting 96-104
tutorial 5-24

N- DATA file 55, 84, 86, 91,

92

P1NDBR.DEF file 90
PINDEH ROOT fife 55, 86, 91
5 25-inch disk drive icon 43-44

5.25-inch disk drives, slot

equivalents of 117

525-inch disks 43
ejecting with Finder 55, 56
See also disk(s)

folders 13, 58-61

copying 61-72

copying into same folder 63-64
copying onto different disk

67-71

copying, options for 71-72
creating 59-60
destination 62

discarding into Trash 73
discarding using Remove
command 74

empty 85

locking 75-76
moving 61-72

moving into folder on same disk

64-67

moving onto different disk

67-71

moving, options for 71-72
opening 60-61

ring from Trash 74

source 62

unlocking 75-76

See also subdirectories

fonts (LaserWriter) 199

Format a Disk option (M;

123, 161, 170

Format a Disk screen 124, 162

formatting disks, See initializing

disks

Get Info command (File menu)
76, 85, 93

H

hard disk 43. See also disk(s)

help (Main Menu) 143-1 I i

Help command (Apple menu) 82
"Hide the Finder's data files"

option 91

horizontal scroll bar. See Scroll bars

I. J

icons 8

color of 91-93

defined 5

deselecting 35
moving 8-10

naming 38-39
opening 10-13

selecting 8-10, 34
starting up applications from
79-80

See also specific icon

ImageWriter 194

choosing. See Chooser

naming. See Namer
ImageWriter AppleTalk a trd L$H

ImageWritcr emulator 197

Initialize Disk command
(Special menu) 90

initializing disks

with Finder 20-22, 44^16
with System Utflities 122-126,

161-163

See also erasing disks

inserting text 36
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keyboard alternatives 12, 93

LaserWriter 194, 197

choosing- See Chooser

fonts 199

naming. See Namer
listing volumes (with System

Utilities) 157-158

List Volumes Option (Main Menu)

157

List Volumes screen 158

Locked check box 76

locking files (wnh System Utilities)

173-175

locking files/folders (with Finder)

75-76
Lock/Unlock Files <

(Main Menu) I 74

I.ock/LJnIock Files screen 175

M
Main Menu 155, 167, 179

Catalog a Disk option 126, 150,

156

Copy Files option 134, 151,

158, 168, 182

Create Subdirectory option 132,

180

Delete Files option 170

Duplicate a Disk option 150,

158, 159

Format a Disk option 123, l6l,

170

help 143-

List Volumes option is?

Lock/Unlock Files option 174

ProDOS Pathname option 135,

146

Quit option 152

Rename Files option 172

Rename Volumes option 185

selecting from 144 1 r
Set Prefix option 1R2, 183

Slot and Drive option 124. 132,

134, 146

Verify a Disk option 163-1 64

marking files. See selecting

memory
requirements for Finder xv-xvi

requirements for System Utilities

xvi-xvii

memory expansion card xvi, 43

slot for 117

menus/menu commands, See

command (5) orspecific menu
name or menu command

messages

Finder 96-104

System Utilities 188-191

moving
icons 8-10

windows 28-29

moving files/folders (with Finder)

61

into folder on same disk 64-67

onto differeni disk 67-71

options for 71-72

summary 62

N

Namer 194—196

NAMER.ll application 195

Names window
naming

disks (with System Utilities}

148-150, 185

files (with System Utilities)

148-150, 172-173

icons 38-39

printers. See Namer
network- See Apple-Talk network

network utilities- See AppIeTalk

network uti

New Folder command (File menu)

59, 85, 93

O

1 ![h n command (File menu) 12,

93

opening

disk drive icons 42-44

disk icons 42-44

disks (with Program Launcher)

111

folders 60-6l

icons 10—13

subdirectories 110

operating systems 125

choosing 150-151

See also DOS 3-3; Pascal; Pr<

Optton(s)

Catalog a Disk 126, 150, 156

Compare Disks 115-116

Copy Disks 113-115

Copy Files 131, 151, 158, 168,

182

Create Subdirectory 132, 180

I tetete Files 170

Duplicate a Disk 150, 158, 159

Format a Disk 123, 161 , 170

Lis! Volumes 157

Lock/Unlock Files 174

ProDOS Pathname 135, 146

Quit 152

Rename Files 172

Rename Volumes 185

Set Prefix 182, 183

Slot and Drive 124, L32, 134,

146

Verify a Disk 163-164

Option key 51, 55, 71, 84, 85, 86,

92

Pascal xvi, 150-151

disks, naming 150

disks, write protecting 174

lining up applications with 78

See also operating systems

pathname method 1 m
pathnames 39, 58-59, 118, 135,

146, 149-150, 179- IK 1

also subdirectories

Preferences command
(Special menu) *

prefixes, setting 182-184. See also

pathnames; subdirectoa

Print command (File menu) 83

printers. See Chooser; ImageWritt r,

LaserWriter; Namer
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printing on a network. See

Apple-Talk network utilities

problems

Finder 96-104

System Utilities 188-191

ProOOS xv, xvi, 125, 150-151

ProDOS disks, naming with System

Utilities 185

PRODOS file 198

ProDOS Pathname option

(Main Menu) 135, 146

Program Launcher xvi-xvii, 108,

109-111

quilling 111

starting up with 108-109

Proportional 1 font (AppleWorks)

199

Proportional 2 font (AppleWorks)

199

proportional scroll boxes 14-15,

26, 27, 31-33

Put Hack command (File menu)
74, 86

Quick menu 198

Quit command (File menu) 8

option (Main Menu) 152

quilting

Program Launcher 1 I 1

System Utilities 152

HAM (random-access memory)
xv-xvii

RAM disk xvi, xvii, 43

FaslCopy and I 12

Finder and 49, 67

slol for 117

See also disk(s)

random-access memory- l

XV- >. V i

recovering files/Folders (with

Finder) from Trash 74

Remove command (Special menu)
7-1, 89, 93

Rename command (File menu)

39, 86

Rename Files option (Main Menu)

172

Rename Volumes option (Main

Menu) IRS

Rename Volumes screen 185

renaming, See naming

'"Replace all duplicate items" button

53, 66, 70, 72

"Replace items case by ease"

button 72

"Replace this item" button 52, 66,

70

replacing text 38

Reset key 123, 142

"Save Finder information onto

disk" option 55, 84, 86, 91

scroll arrows 26, 27, 32

scroll bars 14-15, 26, 27, 31-33

roll boxes, Sec proportional scroll

boxes

scrolling 14-15, 31-33

All command (Special menu)

35, 89, 93

selecting

files (with System Utilities)

147-148
from Main Menu 144-145

icons 8-10, 34-36

text (wiih Finder) 37

Set Prefix Option (Mam Menu; 182

183

Set Prefix screen 184

Shift-clicking 35

Show Clipboard command
(Fdii menu) 87

Size box 26, 27, 29-30

slash (in pathname; lis. 182

-slot 2 117

Slot 5 137

slot 6 117

slot 7

slot-and-dnve rneihod 127, 146

Slot and Drive option (Main Menu)
124, 132, 134, 1 i

slol numbei 124 127, 132, 146

slots 116-117

smart blot k cop)

source disk 46, 62

source folder 62

Space bar 136, 147

Special menu 89-91

Cleanup command 89

Eject command 56, 89, 93

Empty Trash command 73, 89,

command 54

Erase Disk command 90

Initialize Disk command 90

Preferences command 55,

90-9 I

Remove command 74, 89, 93

Select All command 35, 89

starting up

from a document icon 79-80

from an application icon 79

System Utilities 17-20, 142-143

with DOS 3-3 78

with Finder 7-8, 17-20, 78-80

with Pascal 78

wiih Program Launcher

108-109, 110

subdirectories 59

creating 129-134, 179-182

opening 110

See also folders, pathnames;

prefl

SYSTEM.DISK icon 8

i Utilities xvi-xvii, 108,

116-118, 120-121

disks and 120 121

escaping 152

files and 121

memory requirements for

xvi-xvn

quitting 152

Marling up 17-20, 142-143

troubleshooting 188-191

tutorial 121-138

SYS.UTILS folder 17, 123. I i%

198

SYSIJTILSYSTFM application

123, 143

text

deleting 37-38
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inserting 36

replacing 38

selecting 37

3. 5-inch disk drives, sloi

equivalents of 117

3 5-inch disks 43

ejecting with Finder 56

See also djsk(s)

rimes (font) 199

title bar 26, 27

Trash

discarding files/folders with

Finder into 73

ejecting disks with 55

icon 8

recovering files/folders with

Finder Irom 74

troubleshooting

Finder 96-104

System Utilities 138-191

tutorial

Finder 5-24

System Utilities 123-138

By Small Icon command fi

volume- name 162

volumes 120. 163

listing with System Utilities

157-158

See also disk(s)

W, X. Y

windows 8, 13, 26-33

active 18, 27-28

dosing 20, 30-31

moving 28-29

size of, changing 29-30

write protecting

disks (with Finder) 6

Pascal disks 174

zones (ApplcTalk network) 197

zoom box 15-16, 26, 27, 30

U

unlocking files (with System

Utilities) 173-175

unlocking files/folders

<with Finder) 75-76

UNTITLED fotder 60, 85
User Name box 197

i nil nies. See Chooser; FastCopy;

Finder, Namer; Program

Launcher-, System Utilities

Verily a Disk option (Main Menu)
163

Verify a Disk screen 164

verifying disks Cwilh System

Utilities) 163- J: i

vertical scroll bar. See scroll bars

menu 16, 87-88

By Date command 88

By Icon command 16, 87
By Kind command 88

By N'ame command 16. K8

By Size command 88
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